Technical support

If you purchased Optiwave software from a distributor that is not listed here, please send technical questions to your distributor.

<table>
<thead>
<tr>
<th>Optiwave</th>
<th>Canada/US</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel</td>
<td>(613) 224-4700</td>
</tr>
<tr>
<td>Fax</td>
<td>(613) 224-4706</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cybernet Systems Co., Ltd.</th>
<th>Japan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel</td>
<td>+81 (03) 5978-5414</td>
</tr>
<tr>
<td>Fax</td>
<td>+81 (03) 5978-6082</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Optiwave Europe</th>
<th>Europe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel</td>
<td>+33 (0) 494 08 27 97</td>
</tr>
<tr>
<td>Fax</td>
<td>+33 (0) 494 33 65 76</td>
</tr>
</tbody>
</table>
Table of Contents

Table of Contents........................................................................................................1

CHAPTER 1: WELCOME TO OptiGrating 4.2............................................................9

What is new in version 4.2 of OptiGrating ...............................................................9
Installing OptiGrating 4.2..........................................................................................10
Hardware and Software Requirements .................................................................10
Protection key.............................................................................................................10
OptiGrating Directory..............................................................................................11
Installation.................................................................................................................11
How to Learn OptiGrating 4.2 and Where to Find Help ............................................11
Tour of the OptiGrating Main and Project Windows..............................................13
An Overview of Basic Concepts..............................................................................15
An Overview of Basic Features in OptiGrating.......................................................16

CHAPTER 2: TECHNICAL BACKGROUND ..........................................................19

Integrated & Fiber Optical Gratings......................................................................19
The Coupled Mode Theory Method ......................................................................19
Index profile of fibers or slab waveguides............................................................20
Waveguide Modes..................................................................................................22
Material and Waveguide Dispersion.....................................................................24
Complex Index profile............................................................................................25
Photosensitivity profile of the fiber and the slab waveguide...............................26
Grating Device Modeling.......................................................................................26
Coupled Mode Equations......................................................................................30
Transfer Matrix Method.........................................................................................30
Grating Pulse Response..........................................................................................31
Fiber Grating Sensor..............................................................................................31
Grating Device Characteristics..............................................................................33
CHAPTER 3: THE OptiGrating TUTORIAL ..............................................................39

Lesson 1 : Designing a Fiber Bragg Grating ...............................................................39
Lesson 2 : Sensors ........................................................................................................56
Lesson 3 : Material Dispersion .....................................................................................58
Lesson 4 : Parameter Scan ..........................................................................................66
Lesson 5 : Synthesis of a Band Pass Filter .................................................................76
Lesson 6 : Reconstruction of Unknown Grating from Reflection Coefficient ..........82
Lesson 7 : Synthesis of a Grating for Dispersion Compensation ............................88
Lesson 8 : Synthesis of a Filter with User-Defined Spectrum ..................................93

Examples.....................................................................................................................97

Example 1: FBGApod.ifo..........................................................................................97
Apodized Fiber Bragg Grating Simulation.................................................................97
Example 2: SuperStructure.ifo ................................................................................98
Sampled grating.......................................................................................................98
Example 3: ModeConversion.ifo..............................................................................99
Mode Conversion by Fiber Bragg Grating.................................................................99
Example 4: WBGTransmission.ifo ..........................................................................100
Phase-shifted Bragg Grating Filter Based on Planar Waveguide .........................100
Example 5: LPGGainFlat.ifo...................................................................................101
Long-period Fiber Grating for Gain Flattening ......................................................101
Example 6: PulseUltrshort1.ifo .............................................................................102
Pulse Reshaping by Uniform Fiber Grating.............................................................102
Example 7: PulseUltrshort2.ifo .............................................................................104
Pulse Reshaping by Apodized Fiber Gratings.........................................................104
Example 8: MoireGrating.ifo................................................................................106
In-Fiber Moiré Gratings.........................................................................................106

CHAPTER 4: USER GUIDE .....................................................................................109
Single Fiber ......................................................................................................................................... 112

The Single Fiber Profile Dialog Box .......................................................................................... 112
To open the Single Fiber dialog box ............................................................................................ 112
Material Dispersion dialog box ..................................................................................................... 119
To get the Material Dispersion dialog box: .................................................................................. 119
Sellmeier Parameters dialog box .................................................................................................. 120
Function Definition dialog box ..................................................................................................... 122
Gaussian User Function dialog box ............................................................................................... 123
Alpha Power Law dialog box........................................................................................................ 124
Alpha –dip index profile: .............................................................................................................. 124
User Defined Function dialog box ................................................................................................ 125
Single Fiber Modes dialog box ...................................................................................................... 125
Settings .......................................................................................................................................... 126
Advanced Settings ........................................................................................................................ 128
To compute guided modes.......................................................................................................... 129
3D Preview of the field dialog box................................................................................................. 129
Using Calculation Options ........................................................................................................... 130
Propagation .................................................................................................................................... 130
Spectrum ......................................................................................................................................... 131
Pulse Response ............................................................................................................................... 131
Parameter Scan ............................................................................................................................... 132
Setting Options in the Fiber Bragg Grating Sensor Dialog Box ................................................... 133
Setting options in the Long Period Grating Sensor dialog box................................................... 134

The Fiber Coupler ................................................................................................................................ 136

The Fiber Coupler Module ........................................................................................................... 136
To select the Fiber Coupler module............................................................................................... 136
The Fiber Coupler dialog box ......................................................................................................... 136
To open the Fiber Coupler dialog box ........................................................................................... 137
Fiber Coupler Modes dialog box ..................................................................................................... 138
To compute guided modes in the Fiber Coupler Modes dialog box ........................................... 139

Single Waveguide ................................................................................................................................ 141
The Single Waveguide Module .................................................................141
To select the Single Waveguide module ....................................................141
The Single Waveguide Profile dialog box ....................................................141
To open the Single Waveguide dialog box ..................................................141
Photosensitivity .........................................................................................142
Single Waveguide Modes dialog box ..........................................................143
To compute guided modes in the Single Waveguide Modes dialog box .......145
2D Preview of the field dialog box .................................................................147
Using Calculation Options .........................................................................148

Waveguide Coupler ......................................................................................148
The Waveguide Coupler Module .................................................................148
The Waveguide Coupler Profile dialog box ..................................................149
To open the Waveguide Coupler dialog box ................................................149
Waveguide Coupler Modes dialog box ........................................................150
To compute waveguide coupler modes .......................................................152
Using Calculation Options .........................................................................153

Other Waveguide ........................................................................................153
The Other Waveguide Module .................................................................153
To choose the Other Waveguide module .....................................................153
The Mode Properties Dialog Box ...............................................................153
To open the mode properties dialog box .....................................................153
Using Calculation Options .........................................................................155

Open ............................................................................................................156
Save Workspace ..........................................................................................157

The Edit Menu .............................................................................................157
The View Menu ............................................................................................158
The Calculation Menu ................................................................................160
The Scan dialog box ......................................................................................161
The Inverse Scattering Solver .....................................................................162

The Parameters Menu ................................................................................164
Grating Manager ....................................................................................................165
Setting Options in the Grating Definition Dialog Box..............................................167
From File ................................................................................................................169
User Defined ..........................................................................................................171

The Tools Menu .................................................................................................................175
FWHM ....................................................................................................................176
Using the FWHM Command ..................................................................................176
To perform a Full Width At Half Maximum calculation ...........................................176
The FWHM Tools dialog box..................................................................................177
Group Delay ...........................................................................................................178
Export Curve ..........................................................................................................180
Crossection Monitor ...............................................................................................181

The Settings Menu ........................................................................................................182
Display ...................................................................................................................183
Re-sampling 3D Propagation Graphs ....................................................................184
To define a graph's properties when working in a 3D view....................................184
Profile Palette .........................................................................................................185

The Window Menu........................................................................................................186

The Help Menu..................................................................................................................187

APPENDIX A: SCRIPT LANGUAGE FOR USERDEFINED FUNCTIONS ...........189

Variables, Arrays, and Operators ..................................................................................189

Variables ................................................................................................................189
Arrays.....................................................................................................................189
Mathematical Operators .........................................................................................189
Boolean Operators .................................................................................................190
Comparison Operators ...........................................................................................190

Commands and Statements: RETURN, IF, ERROR..................................................190

The RETURN Command .......................................................................................190
The IF Statement .................................................................................................191
The ERROR Keyword ..........................................................................................192
Welcome to OptiGrating 4.2

Welcome to OptiGrating 4.2 - a powerful and user-friendly design software for modeling integrated and fiber optic devices that are assisted by optical gratings. The operation of many telecom and sensor devices is based on optical gratings which alter coupling between guided light modes. For example, waveguide grating technology has been used in WDM optical networks, laser stabilization, and temperature and strain sensing. A grating-assisted device can be analyzed and designed by calculating light propagation, reflection and transmission spectra, the phase group delay, and the dispersion. While the calculation results depend on waveguide and grating parameters, the design task can be greatly facilitated by the use of the appropriate computer software: OptiGrating 4.2.

OptiGrating 4.2 offers you different options for analyzing and designing typical grating assisted fibers and waveguides. You can select one of the options and set device parameters. For example, the design of a Bragg fiber grating filter involves adjustments of the grating shape, length, apodization, index modulation and chirp, according to the fiber diameter and refractive index. Once such a device setup is done, you can use the program to perform numerical simulations. Such simulations are based on solving coupled mode equations that describe the interaction of guided modes. The coupled mode equations are solved by the Transfer Matrix Method (a fundamental matrix method).

What is new in version 4.2 of OptiGrating

The OptiGrating 4.2 has the following new features:

**Inverse scattering problem solver**

A powerful new module solves the inverse scattering problem of Bragg gratings. This new feature can be used in one of two ways. First, it can be used to reconstruct an unknown grating from knowledge of the reflection spectrum. Second, if the user has certain required spectral characteristics and would like to design such a grating, this feature can aid in the synthesis of the device.

**Advanced slab waveguide and fiber mode solver**

The solver can be used to find guide gain/loss and leaky modes. These modes have complex modal indices, so the search for the solutions is more difficult, as the search space is twodimensional. However, OptiGrating Version 4.2 uses an advanced technique for finding these solutions. A region is specified in the complex plane by giving limits to the imaginary values as well as the real ones, defining a rectangular shaped contour in the complex plane. OptiGrating makes a series of numerical contour integrations to construct a polynomial with zeros at the solutions, and then solves the polynomial problem by standard techniques. The result is a fast, accurate, and very reliable solver.
CHAPTER 1: WELCOME TO OPTI GRATING 4.2

Group Delay Analysis tool

This new feature is a curve fitting regression technique with a graphical interface. You can see the tool fit linear, quadratic, or arbitrary order curves to the calculated group delay. In this way the user can quickly get data for characterizing the group delay, GDD, and ripple automatically.

Increased export options

OptiGrating now gives the user a yet another option when exporting complex spectrum data. In addition to the Text and BPM_CAD View 2D choices, OptiSystem is now also available. The OptiSystem option allows the user to export both transmission and reflection into one single file containing wavelength, transmittivity real part, transmittivity imaginary part, reflectivity real part, and reflectivity imaginary part. This file can be used as an input file for OptiSystem.

Improved functionality

OptiGrating 4.2 improves the overall functionality in several areas, including new commands that allow the user to work within Fiber/Waveguide with greater ease.

Installing OptiGrating 4.2

Before installing OptiGrating 4.2, make sure that you have the system requirements described below.

Hardware and Software Requirements

OptiGrating 4.2 requires the following system configuration:

• Personal computer with the Pentium processor
• Microsoft Windows 2000 or Windows XP
• 20MB free hard disk space
• Graphic resolution of 1024 x 768, minimum 256 colors

Protection key

A hardware protection key is supplied with the software.

Note: Please ensure that the hardware protection key is NOT connected during the installation of OptiGrating.

To ensure that OptiGrating operates properly, verify the following:

• The protection key is properly connected to the parallel/USB port of the computer.
• If you use more than one protection key, ensure that there is no conflict between the OptiGrating protection key and the other keys.

Note: Use a switch box to prevent protection key conflicts. Ensure that the cable between the switch box and the computer is a maximum of one meter long.
OptiGrating Directory

By default, the Installer will create an OptiGrating directory on your hard disk. The OptiGrating directory will contain the following subdirectories:

\SAMPLES – contains examples
\DOC – contains OptiGrating manual as a PDF file (requires Adobe Acrobat Reader: download for free at www.adobe.com)
\USERFUN – contains pre-defined user-defined functions
\BIN – contains OptiGrating executables and dlls.

Installation

It is recommended that you exit all Windows programs before running the setup program.

To install OptiGrating

1. Log on as the Administrator, or on an account with administrative privileges. Otherwise, start with step two.
2. Insert CD into your CD driver.
3. Press the Start button and select Run.
4. In the Run dialog box, type the command line x:\setup.exe, where x is the CD-Rom drive.
5. Click the OK button and follow the screen instructions and prompts.

Note: After completing the installation, reboot the computer.

How to Learn OptiGrating 4.2 and Where to Find Help

You can quickly become an efficient OptiGrating user by carefully reading the Technical Background chapter, doing the Tutorial lessons, referring to the User Guide, and consulting the Online Help.

The Technical Background chapter

The Technical Background chapter offers you a summary of the theoretical concepts on which integrated and fiber optical gratings is based. You will find not only helpful definitions and a number of important formulas you will use quite often, but also a list of technical references as well.

The OptiGrating Tutorial

The best way to learn how to work with OptiGrating is to do the Tutorial lessons. By following the step-by-step instructions, you will see how quickly you can become an highly efficient OptiGrating user.
The OptiGrating User Guide

The User Guide describes in detail some of the most important commands and options available in OptiGrating. For your convenience, the commands are listed according to the menus under which they appear in the program. The task-oriented topics, which provide illustrations and examples to help you understand OptiGrating concepts, contain everything you will need to do your work quickly and effectively.

Online Help

You can also find additional information on using OptiGrating in the Online Help. To access Online Help, from the Help menu click Help Topics. Use either the Contents tab, the Find tab, or the Index tab to get the information you need.
Tour of the OptiGrating Main and Project Windows

After you create a new project or open an existing one, you will see the OptiGrating Main Window, as shown below.

The Main Window

The Main Window of OptiGrating 4.2 is a multi-document interface that allows you to open several grating projects simultaneously.

The Menu Bar displays the command and option menus that OptiGrating offers you.

The Toolbar displays the buttons you can use to speed up your work.

OptiGrating 4.2 allows you to use not only the standard buttons for working with files but also the Clone View, FWHM Tools. You will find detailed information about those buttons in the User Guide.
The Project Window

The Project Window contains the Data Entry Pane (on the left side of the window) and the graphic display (on the right side of the window). The Data Entry Pane enables you to select one of the calculation options, to set the range of the calculation variable, the number of calculation steps, etc. The command buttons provide an easy access to the most often used commands. You can control the graphic display by using the Display tabs.

The Toggle Pane button toggles the display between the window that has a Data Entry Pane and the Graphics window.

The Display Curves buttons turn on and off the following curves: Transmission 1, Transmission 2, Reflection 1, and Reflection 2.

The Calculation list box offers you the following options: Propagation, Spectrum, Pulse Response.

Edit Parameters consist of the following buttons (from top down): Fiber/ Waveguide parameters (edit fibers or waveguides), Mode parameters (edit list of modes), and Grating parameters (edit gratings).

The Calculate button starts numerical calculations.

The Display tabs switch the display between different characteristics.
An Overview of Basic Concepts

What is a Main Window

The main window of OptiGrating is a multi-document interface which allows you to open several grating projects simultaneously.

You can also use a Multiple Window view. It is important to remember that you get different tools, exporting curves, and printing options that are specific for each active window, i.e. the window you are currently using. In the Multiple Window view, the project window is split in two. The Input View window, with all edit boxes, is on the left; the graph is on the right. If your active window is Input view, you cannot print, export a curve, or use any of the tools. In order to be able to do all those operations, you have to click in the window containing the graph.

What is a Workspace

In OptiGrating, you can save your multiple graph windows as a workspace. When you use the Save Workspace option, you are saving not only multiple windows but also all the information (settings, position and size of the windows, etc.) stored in those windows. When you open a saved workspace, you actually open all of the projects or views saved in that workspace.

What is a Template

A template is a collection of settings and options that work together to govern the overall appearance of a project. Templates can be applied at any time when you are working with OptiGrating. When you want to apply a template, you have to define the files you want to open with that template.

How to Clone Views

To facilitate your work, OptiGrating allows you to clone views. You can create as many windows as you want and arrange them in an order that best suits your style of work. It is important to remember that all windows share the same document and that they are displaying the same data but from different view points. If you decide to recalculate, i.e. change the data, all windows will be redrawn.

How to view graphs effectively

In each window that contains a 2D graph, there are four different curves. You can see one or more of those curves by using the color buttons on the small toolbar. To activate the buttons, click the graph at the top of the Multiple Window view. You can access a pop-up menu by clicking the right mouse button in a particular window. The pop-up menu that opens shows you the graph tools you can use in this window.

Saving IFO data files

By default, *.ifo data files are saved with all graphs (with the exception of 3D Propagation graphs). The next time you load the file, you will immediately see the graphs, i.e. no re-computation will be done. A Data file, with the graphs included, is about a hundred KB. If you disable the Save Display Data to *.IFO File check box in the General Settings dialog box, your files will be about 10KB. However, to see the graphs, you will have to re-calculate every time you open the file.
Using Pop-up (Context) Menus

You can access a pop-up menu by double clicking the left mouse button in a particular window. The pop-up menu that opens shows you the tools you can use in this window.

When you use the left mouse button to click inside a window, you automatically make the window active.

An Overview of Basic Features in OptiGrating

The most important feature applications of OptiGrating are the following:

- WDM add/drop, narrow and broadband fiber and waveguide filters
- Fiber Bragg reflectors
- EDFA gain flattening elements
- Dispersion compensators for fiber communications
- Sideband suppression using grating apodization
- Fiber and waveguide sensors

Using Pre-defined Device Configurations

OptiGrating allows you to use the following pre-defined device configurations:

- Single fiber with grating(s)
- Two fiber coupler with grating(s)
- Asymmetric slab waveguide with grating(s)
- Two slab coupler with grating(s)
- Other waveguide with grating(s)

**Note:** For each device configuration, a mode solver provides a complete list of waveguide modes. You can design the grating that assists coupling between selected modes and has control over all device parameters.

Working With Default Device Configurations

All default device configurations have the following common grating options:

- Grating shape: Rectangular, Sine, From File, or User Defined Function
- Average Index: Uniform, Linear, From File, or User Defined Function.
- Period chirp: Linear, Quadratic, Square Root, Cubic Root, From File, or User Defined Function
- Apodization: Gaussian, Hyperbolic Tangent, From File, or User Defined Function
- Adjustable parameters: Period, Length, Index Modulation or Height, Shift, Order, Tilt Angle, and Number Of Segments

Using Simulated Device Characteristics

OptiGrating simulates device characteristics according to the following calculation options:
• Propagation - reflected and transmitted power along the propagation distance in the device, calculated for a given wavelength
• Spectrum - reflected and transmitted power, cumulative phase, group delay, and dispersion versus wavelength, calculated at the input and output ports of the device
• Pulse response - input pulse intensity spectrum, grating spectrum, output pulse intensity
• Scan – bandwidth, sidelobe, peak value, peak position, and dispersion at central wavelength versus scan parameter (all the parameters of grating are scanable)
CHAPTER 2: TECHNICAL BACKGROUND

Technical Background

Integrated & Fiber Optical Gratings

An integrated or fiber optic grating is a periodic modulation of the refractive index in a waveguide or on the surface of a waveguide. It can be fabricated by using either two-beam interferometry or near-field holography through an optical phase mask. Waveguide gratings play an important role in WDM systems since they can be used for controlling, combining, and routing light. OptiGrating 4.2 is based on the Coupled Mode Theory (CMT). The program has built-in mode solvers providing modal constants and fields needed to formulate the Coupled Mode Equations (CMEs). In turn, the Coupled Mode Equations are solved by using Transfer Matrix Method (TMM).

The Coupled Mode Theory Method

Coupled Mode Theory is a method to analyze the light propagation in perturbed or weakly coupled waveguides. The basic idea of the Coupled Mode Theory method is that the modes of the unperturbed or uncoupled structures are defined and solved first. Then, a linear combination of these modes is used as a trial solution to Maxwell’s equations for complicated perturbed or coupled structures. After that, the derived coupled mode equations can be solved analytically or by numerical methods. The theory assumes that the field of the coupled structures may be sufficiently represented by a linear superposition of the modes of the unperturbed structures. In many practical cases, this assumption is valid and does give an insightful and often accurate mathematical description of electromagnetic wave propagation. The Coupled Mode Theory is most useful in the analysis of the interaction between several near resonance guided modes. It has been widely used and proven to be one of the most productive and efficient methods for the analysis of waveguide devices.
Index profile of fibers or slab waveguides

The radial distribution of the fiber refractive index is called the index profile. In the case of a slab waveguide, the transverse refractive index is called the index profile. The index profile determines guiding properties of the fiber or slab waveguide. In general, the core region has a higher index than the cladding region. However, the index profile can have regions where the index is lower than the cladding value. Modern fiber or slab waveguide designs are based on index profiles that assure proper operation within a range of wavelengths.

For example, a dispersion flattened fiber design involves a few concentric index regions.

![Fiber Profile](image)

In OptiGrating 4.2, regions define a fiber or slab waveguide profile. Each region has its dimension (width) and refractive index profile. The default refractive index profile options are listed below, where $x$ is the region’s local coordinate, $w$ is the width of the region.

**Constant index profile:**

$$n(x) = \text{const}$$  \hspace{1cm} (1)

**Linear index profile:**

$$n(x) = n(0) + x \cdot \frac{n(w) - n(0)}{w}$$  \hspace{1cm} (2)
Parabolic index profile:

\[ n(x) = [n(w) - n(0)] \cdot \left(\frac{x}{w}\right)^2 + n(0) \]  \hspace{1cm} (3)

Exponential index profile:

\[ n(x) = [n(0) - n(w)] \cdot \frac{e}{e - 1} \cdot \exp\left(\frac{-x}{w}\right) + \frac{e \cdot n(w) - n(0)}{e - 1} \]  \hspace{1cm} (4)

where \( n(0), n(w) \) is the refractive index at \( x=0 \) and \( x=w \), respectively.

Gaussian index profile:

\[ n(x) = n_{\text{max}} \exp\left\{-\ln 2 \cdot \left[\frac{2 \cdot (x - x_0)}{h \cdot w}\right]^2\right\} \]  \hspace{1cm} (5)

where \( n_{\text{max}} \) is the maximum index value, \( x_0 \) is the peak position, and \( h \) is the normalized value of FWHM.

Alpha-peak index profile:

\[ n(x) = n_{\text{max}} \cdot \sqrt{1 - 2\Delta \cdot \left(\frac{x}{w}\right)^\alpha} \]  \hspace{1cm} (6)

where \( n_{\text{max}} \) is the maximum index value, and \( \Delta \) is the normalized index difference. The difference is defined as

\[ \Delta = \frac{n_{\text{max}}^2 - n_{\text{min}}^2}{2n_{\text{max}}^2} \]  \hspace{1cm} (7)

Alpha-dip index profile:

\[ n(x) = n_{\text{max}} \cdot \sqrt{1 - 2\Delta \cdot \left(1 - \frac{x}{w}\right)^\alpha} \]  \hspace{1cm} (8)

where \( n_{\text{max}} \) is the maximum index value, and \( \Delta \) is the normalized index difference.
Waveguide Modes

In a waveguide, light propagates in the form of modes. OptiGrating 4.2 uses LP Fiber modes, Vector Fiber modes, and Slab Waveguide modes.

LP Fiber Modes

The designation of Linearly Polarized (LP) Fiber modes is based on the assumption of weak guidance. Weakly guiding fibers have a small difference between core and cladding refractive index.

The LP \((m, n)\) modes are designated by two numbers:

1. \(m\) – azimuthal number
2. \(n\) – orbital number

where \(m=0, 1, 2, \ldots\) and \(n=1, 2, \ldots\).

Both guided and cladding modes of arbitrary circular symmetric refractive index profiles are calculated either by the accurate finite difference method or by the analytical method (step index profile). The fundamental mode of fiber is LP \((0,1)\).

Vector Fiber Modes

The designation of Vector Fiber modes TE, TM, EH, and HE follows the convention:

1. \(TE(0,n)\) – transverse electric family of modes
2. \(TM(0,n)\) – transverse magnetic family of modes
3. \(EH(m, n)\) – hybrid family of modes
4. \(HE(m, n)\) – hybrid family of modes

where \(m>0\) and \(n=1, 2, \ldots\).

In OptiGrating 4.2, the vector modes are calculated only for the step-index fiber. The stepindex calculations are based on the analytical approach. The fundamental mode of the stepindex fiber is HE \((1,1)\).

Slab Waveguide Modes

The Slab Waveguide modes are the following:

1. \(TE(m)\) – transverse electric family of modes, \(m=0, 1, 2, \ldots\)
2. \(TM(m)\) – transverse magnetic family of modes, \(m=0, 1, 2, \ldots\)

The modes of a slab waveguide with arbitrary refractive index profile are calculated either by the Transfer Matrix Method or by the analytical method (step index profile). The fundamental mode is \(TE(0)\) or \(TM(0)\).

Mode Solver

Near the end of any calculation that finds the modes of an optical waveguide, it is necessary to find the solution of an equation. This equation is a function of the
propagation constant $\beta$ and typically includes mixed trigonometric and exponential functions. Therefore a numerical solution, rather than an analytic one, is sought. For waveguides composed of lossless materials, the proper modes are easy to find since they are real numbers. Simple numerical routines need only to be provided with an interval on the real axis where the solutions can be expected, and it is a simple matter to find them all. On the other hand, in the case of leaky waveguides, or in the case of waveguides composed of lossy materials, the equation may still have solutions, but with $\beta$ in the complex plane. These solutions are not proper modes, in the sense that the corresponding solutions for the electromagnetic fields are orthogonal to each other, or even (in the case of leaky modes) localised. Nevertheless, the electromagnetic field associated with this complex solution is still a valid solution of Maxwell's equations, and is relevant because it is often a good approximation to the field seen for this waveguide in practice.

The numerical procedure for the so-called complex modes is more difficult, as the search space is two dimensional. However, OptiGrating Version 4.2 uses an advanced technique for finding these solutions. The user must specify a region in the complex plane by giving limits to the imaginary values as well as the real ones. This defines a rectangular shaped contour in the complex $\beta$ plane. By one of the theorems of Cauchy, the number of zeros of a function (minus the number of poles) enclosed in a closed contour in a complex plane is given by the contour integral

$$N_0 = \frac{1}{2\pi j} \oint_c \frac{f'(\beta)}{f(\beta)} d\beta$$

OptiGrating performs the contour integral numerically, and uses the above formula to determine the number of complex modes to be found within the given limits. The calculation of the modes is aided by the numerical evaluation of the following integrals at the same time

$$N_m = \sum_{i=1}^{N_0} \beta_i^m = \frac{1}{2\pi j} \oint_c \beta^m \frac{f'(\beta)}{f(\beta)} d\beta$$

for $m = 1, 2, 3, \ldots, N_0$. In fact, knowledge of the $N_m$ allows the construction of a polynomial that has the same roots as $f(\beta)$. The roots of the polynomial are then solved by standard techniques such as Laguerre’s method. A detailed description of the method can be found in the Reference [1].
Material and Waveguide Dispersion

Material refractive index varies with wavelength and therefore causes the group velocity to vary; it is classified as material dispersion. The wavelength dependence of refractive index can be expressed by Sellmeier’s equation. Waveguide dispersion is the result of wavelength-dependence of the propagation constant of the optical waveguide. It is important in single-mode waveguides. The larger the wavelength, the more the fundamental mode will spread from the core into the cladding. This causes the fundamental mode to propagate faster. The material and waveguide dispersion effect is important when the grating filter has a broadband response, such as a co-directional waveguide coupler and a long period fiber grating. In these cases, the waveguide mode constants are re-calculated for different wavelength by considering material dispersion.

Host materials

Optical telecommunication fibers are usually made from silica glasses. The high purity glass is called the host material or substrate. Its bulk refractive index is usually the fiber cladding refractive index. The fiber core is formed by adding dopant materials to the host material.

Dopant materials

To change the refractive index of optical fiber, pure silica is often doped with dopants. For example, adding germanium can result in an increase in the refractive index, while adding fluorine reduces it. The refractive index of doped material can be determined by the linear relationship between the doped material’s mole percentage and permittivity.

Assume that $n_0$ is the refractive index of the host material and $n_1$ is the refractive index of $m_1$ mole-percentage doped material. Then, the refractive index $n$ of $m$ mole-percentage doped material can be interpolated as:

$$ n^2 = n_0^2 + \frac{m}{m_1}(n_1^2 + n_0^2) $$

Note that this formula can also extrapolate (the case where $m > m_1$).

Material dispersion calculation

In OptiGrating 4.2, when the refractive index at a central wavelength $\lambda_0$, $n(\lambda_0)$, and the host and dopant material dispersion curves, $n_{host}(\lambda)$ and $n_{dopant}(\lambda)$ are defined, the dependence of the refractive index with wavelength, $n(\lambda)$, is calculated based on the following equation:
This equation is the same as (11), with the fraction \( \frac{m}{m_1} \) estimated by comparing, at the centre wavelength \( \lambda_0 \), the refractive index of the given material with the index of a doped material with known Sellmeier coefficients \( n_{\text{dopant}} \). OptiGrating uses Equation 12 to handle the case where the Sellmeier coefficients are known for material of just one doping concentration. If the material in question has the same dopant, but with an unknown concentration, the fraction in Equation 12 will estimate the concentration by comparing the given index \( n(\lambda) \) with the reference index \( n(\lambda_0) \). With the doping concentration estimated this way, the refractive index at other wavelengths is accurately estimated by Equation 12. On the other hand, in the case where the Sellmeier coefficients are exactly known for the given material, the user can enter them himself in OptiGrating’s Sellmeier Coefficient Library. OptiGrating still uses Equation 12, since in this case the fraction is calculated as unity, and the left hand side is assigned to \( n_{\text{dopant}}(\lambda) \) for all wavelengths directly.

### Complex Index profile

In OptiGrating 4.2, the index profile of the fiber or slab waveguide can be complex. The imaginary part of the modal effective index can be calculated by the perturbation method based on the coupled mode theory as:

\[
N
K_{\text{eff}} = \sum_{i = 1}^{N} \Gamma_i K_i
\]

where \( N \) is the number of layers of the waveguide index profile, \( K_i \) is the imaginary part of the refractive index of the \( i \)-th layer material, and \( \Gamma_i \) is the confinement factor of the mode in the \( i \)-th layer. The above equation is based on the perturbation method, and it is only valid when \( K_{\text{eff}} \ll 1 \).
CHAPTER 2: TECHNICAL BACKGROUND

Photosensitivity profile of the fiber and the slab waveguide

It is well known that a germanium-doped silica fiber exhibits photosensitivity, i.e., a permanent change in the refractive index of the core when it is exposed to light from an appropriate laser. High photosensitivity can be achieved by increasing concentration of germanium, codoping suitable elements which has enhanced photosensitivity, and high pressure hydrogen loading etc.

In OptiGrating 4.2, The transverse photosensitive distribution is called the photosensitivity profile. The photosensitivity profile for a fiber can be described as:

\[ P(r, \varphi) = P_r(r) \cdot P_\varphi(\varphi) \]  \hspace{1cm} (14)

where \((r, \varphi)\) is the radial and azimuthal co-ordinates, \(P_r(r)\) is the radial dependent photosensitivity (its value is between 0 and 1.0), and \(P_\varphi(\varphi)\) is the azimuthal dependent photosensitivity (value between 0 and 1.0). The photosensitivity profile for the slab waveguide can be described as \(P(y)\) (value between 0 and 1), where \(y\) is the transverse coordinate of the slab waveguide.

In OptiGrating 4.2, regions define the fiber radial photosensitivity profile or slab waveguide photosensitivity profile. Each region has its dimension (width) and photosensitivity index profile. The default photosensitivity profile options are the same as the default options for the index profile.

Grating Device Modeling

Single Grating Formula

A grating can be represented by the formula that combines a grating shape function, an average index modulation function, a period chirp function, and an apodization function:

\[ n(x, y, z) = n_0(x, y) + \Delta n_0(x, y, z) + \Delta n \cdot P(x, y) \cdot A(z) \cdot f[A(z)/\cos \theta, z] \]  \hspace{1cm} (15)

where

- \(n_0\) - waveguide refractive index
- \(\Delta n\) - index modulation amplitude
- \(\theta\) - grating tilt angle
- \(f[A(z)/\cos \theta, z]\) - shape function
- \(\Delta n_0(z)\) - average index modulation function
- \(A(z)\) - period chirp function
CHAPTER 2: TECHNICAL BACKGROUND

\( A(z) \) - apodization function

\( P \) - Photosensitivity profile of waveguide

In Equation 15, the average index modulation function \( \Delta n_0 \) is applied only in the region of the grating, i.e. in layers with non-zero photosensitivity. Layers with very small photosensitivity will respond to average index modulation, but the grating will be very weak there.

If the User wants to apply the Average Index change to a layer that does not contain the grating, he should enter a very small number (.01) for the Photosensitivity of that layer.

Detailed definitions are given below.

**Grating Shape**

In OptiGrating, the Grating Shape is the profile of index modulation within one grating period \( \Lambda \).

The default grating shapes are:

- Rectangle

\[
f(z) = \begin{cases} 
  +1 & \text{if } 0 < z < \Lambda / 2 \\
  -1 & \text{elsewhere}
\end{cases}
\]  

(16)

- Sine

\[
f(z) = \sin \left( \frac{2\pi}{\Lambda} z \right)
\]  

(17)

Other grating shapes can be supplied from a user file or defined by user functions.

**Average Index Modulation**

In OptiGrating, the Average Index Modulation is the average index change along the grating length. The default average index modulations are listed below. The symbol delta \( (\Delta) \) is the total index change along the grating.

- Uniform

\[
\Delta n_0 = \Delta \quad \Delta \ll n_0
\]  

(18)
CHAPTER 2: TECHNICAL BACKGROUND

• Linear

\[ \Delta n_0 = \frac{z - L/2}{L} \Delta \quad \Delta \ll n_0 \]  

(19)

Other average index modulations can be supplied from a user file or defined by user functions.

**Grating Period Chirp**

Grating Period Chirp is the distance-dependent grating period modulation. The default Period Chirp options are listed below, where the constant chirp term is the grating period in the middle of the grating, L is the grating length, and the symbol delta (\( \Delta \)) stands for the total chirp.

• No chirp (constant period):

\[ \Lambda(z) = \Lambda_0 \]  

(20)

• Linear:

\[ \Lambda(z) = \Lambda_0 - \frac{z - L/2}{L} \Delta \quad \Delta \ll \Lambda_0 \]  

(21)

• Quadratic:

\[ \Lambda(z) = \Lambda_0 - \left[ \left( \frac{z}{L} \right)^2 - \frac{1}{4} \right] \Delta \quad \Delta \ll \Lambda_0 \]  

(22)

• Square root:

\[ \Lambda(z) = \Lambda_0 - \left[ \left( \frac{z}{L} \right)^{1/2} - \frac{1}{\sqrt{2}} \right] \Delta \quad \Delta \ll \Lambda_0 \]  

(23)

• Cubic root:

\[ \Lambda(z) = \Lambda_0 - \left[ \left( \frac{z}{L} \right)^{1/3} - \frac{1}{3^{1/2}} \right] \Delta \quad \Delta \ll \Lambda_0 \]  

(24)

Other chirp forms can be supplied from a user file or defined by user functions.

**Grating Apodization**

The Grating Apodization is the slowly varying envelope of the grating profile.
The default apodization options are listed below, where $s$ is the taper parameter and $L$ is the grating length.

- Uniform (no apodization):
  \[ A(z) = 1 \]  \hfill (25)

- Gaussian:
  \[ A(z) = \exp \left\{ -\ln 2 \cdot \left[ \frac{2 \cdot \left( \frac{z-L}{2} \right)}{s \cdot L} \right]^2 \right\} \]  \hfill (26)

- Hyperbolic tangent:
  \[ A(z) = \tanh \left( s \cdot \frac{z}{L} \right) \cdot \tanh \left[ s \cdot \left( 1 - \frac{z}{L} \right) \right] + 1 - \tanh^2 \left( \frac{s}{2} \right) \]  \hfill (27)

Other chirp forms can be supplied from a user file or defined by user functions.

**Phase Shift**

The Phase Shift element is a piece of the current waveguide structure without the grating.

The Phase Shift element can be defined alternatively by one of the two parameters:
- Phase – phase change accumulated in the Phase Shift element
- Length – length of the element

**Multiple Gratings**

You can simulate a collection of gratings and phase shifts in one waveguide device.
CHAPTER 2: TECHNICAL BACKGROUND

**Coupled Mode Equations**

Assume the electric field is a linear combination of the ideal modes (with no grating perturbation), such that

\[ \hat{E}(z) = \sum_{i} [a_i^{(+)} \exp(-j\beta_i z) + a_i^{(-)} \exp(j\beta_i z)] \hat{e}_i \]  

(28)

where \( a_i^{(+)} \) and \( a_i^{(-)} \) are the slowly varying amplitudes of \( i \)th mode traveling in the +z and −z directions. \( \beta_i \) and \( \hat{e}_i \) is the propagation constant and modal field of the \( i \)th mode.

The above electric field is used as trial solution in the Maxwell’s equation. The following Coupled mode Equations (CMEs) can be derived by using the properties of waveguide modes,

\[ \frac{da_i^{(+)}}{dz} = -j \sum_k \{ a_k^{(+)} k_{ki} \exp[-j \cdot (\beta_k - \beta_i) \cdot z] + a_k^{(-)} k_{ki} \exp[j \cdot (\beta_k + \beta_i) \cdot z] \} \]  

(29)

\[ \frac{da_i^{(-)}}{dz} = j \sum_k \{ a_k^{(+)} k_{ki} \exp[-j \cdot (\beta_k + \beta_i) \cdot z] + a_k^{(-)} k_{ki} \exp[j \cdot (\beta_k - \beta_i) \cdot z] \} \]  

(30)

The coupling coefficient between modes \( k \) and \( i \) is given by:

\[ k_{ki} = \frac{1}{4} \omega \varepsilon_0 \int \int \tilde{n}^2(x, y, z) \hat{e}_k \cdot \hat{e}_i \, dx \, dy \]  

(31)

\[ \tilde{n}^2(x, y, z) = \tilde{n}^2(x, y, z) - n_0^2(x, y) \]  

(32)

where \( \tilde{n}^2(x, y, z) \) is the periodic refractive index perturbation of the grating, and \( n_0(x, y) \) is the index profile of waveguide. \( n(x, y, z) \) is the grating index profile.

In OptiGrating, the coupled mode equations are based on non-orthogonal coupled mode theory. Both the waveguide nature coupling and grating coupling are considered. In order to formulate the coupled mode equations, waveguide modal constants, fields, and coupling coefficients are calculated based on waveguide and grating profiles. The coupled mode equations are then solved by the two mode or by the multi-mode coupling formulation.

**Transfer Matrix Method**

If the device has more than one grating plus phase shifts, the coupled mode equations can be solved by the Transfer Matrix Method. This method can also be used very effectively in the analysis of almost-periodic gratings. The general idea of TMM is that the grating structure is divided into a number of uniform grating sections, which have
CHAPTER 2: TECHNICAL BACKGROUND

an analytic transfer matrix. The transfer matrix for the entire structure can be obtained
by multiplying the individual transfer matrices. The Coupled Mode Equations can be
solved with the initial values.

Grating Pulse Response

The Coupled Mode Equations are derived in the context of a monochromatic
frequency CW light source for linear propagation. The spectrum of the input pulse can
be obtained by taking a Fourier transform of the input time-dependent waveform. The
response to the input pulse can be calculated by considering each spectral
component separately and adding over the spectrum of the input pulse. The output
pulse spectrum can be obtained by multiplying by the appropriate grating device
frequency response. The corresponding output time waveforms can then be
recovered by taking the inverse Fourier transform.

Fiber Grating Sensor

Temperature and strain change the grating period as well as the grating refractive
index. Consequently, the response of the grating device is changed when
temperature and strain distributions change.

Strain-optic effect of fiber Bragg grating

The changes of optical indicatrix caused by strain are:

$$\Delta \left( \frac{1}{n^2} \right) = \sum_{j=1}^{6} P_{ij} \varepsilon_j$$ \hspace{1cm} (33)

where, $\varepsilon_1 = \varepsilon_2 = -\nu\varepsilon$, $\varepsilon_3 = \varepsilon$, $\varepsilon_4 = \varepsilon_5 = \varepsilon_6 = 0$ (no shear strain), and $\varepsilon$
being the axial strain in the optical fiber. The symbol $\nu$ denotes the Poisson’s ratio
for the fiber.

The strain-optical tensor for a homogeneous isotropic material is:

$$P_{ij} = \begin{bmatrix}
P_{11} & P_{12} & P_{12} \\
P_{12} & P_{11} & P_{12} \\
P_{12} & P_{12} & P_{11}
\end{bmatrix}$$ \hspace{1cm} (34)

where $P_{ij}$ are the strain-optic constants,

$$\Delta \left( \frac{1}{n^2} \right)_{x,y} = \Delta \left( \frac{1}{n^2} \right)_{1,2} = \varepsilon P_{12} - \varepsilon \nu (P_{11} + P_{12})$$ \hspace{1cm} (35)
The refractive index change is:

\[
\Delta n = -\frac{1}{2} n^3 \Delta \left(\frac{1}{n^2}\right)_{x,y} = -\frac{1}{2} n^3 \varepsilon [P_{12} - \nu(P_{11} + P_{12})] \tag{36}
\]

\[
\Delta n = n \cdot y \cdot \varepsilon
\]

where the strain-optic coefficient \( y \) is defined as:

\[
y = \frac{1}{n} \frac{dn}{d\varepsilon} = -0.5 \cdot n^2 [P_{12} - \nu(P_{11} + P_{12})] \tag{37}
\]

The grating period changes is:

\[
\Delta \Lambda = \varepsilon \cdot \Lambda \tag{38}
\]

The default strain distributions that can be applied to a fiber grating are listed below:

- Uniform
  \[ \varepsilon = \varepsilon_0 \tag{39} \]

  where \( \varepsilon_0 \) is the constant strain.

- Linear
  \[ \varepsilon(z) = \varepsilon(0) + \frac{\varepsilon(L) - \varepsilon(0)}{L} \cdot z \tag{40} \]

  where \( L \) is the grating length, \( \varepsilon(0) \) is the strain at \( z = 0 \), and \( \varepsilon(L) \) is the strain at \( z = L \).

- Gaussian
  \[ \varepsilon = \varepsilon_0 \cdot \exp \left\{ -\ln 2 \cdot \left[ \frac{2 \cdot (z - L/2)}{w \cdot L} \right]^2 \right\} \tag{41} \]

  where \( \varepsilon_0 \) is the peak strain value and \( w \) is the normalized value of FWHM.

Other strain distributions can be defined by user functions.

**Thermal-optic effect of fiber Bragg grating**

The temperature-induced refractive index change is:

\[
\Delta n = n \cdot \frac{dn}{n \cdot dt} \cdot \Delta T = \xi \cdot n \cdot \Delta T \tag{42}
\]
where $\xi$ is the thermo-optic coefficient of the fiber and $\Delta T$ is the temperature change.

The temperature-induced grating period change is:

$$\Delta \Lambda = \Lambda \cdot \frac{d\Lambda}{\Lambda \cdot dT} \cdot \Delta T = \eta \cdot \Lambda \cdot \Delta T$$ \hspace{1cm} (43)

where $\eta$ is the thermo-optic expansion coefficient.

The default temperature distributions that can be applied to a fiber are listed below:

- **Uniform**
  $$\Delta T = \Delta T_0$$ \hspace{1cm} (44)
  where $\Delta T_0$ is the constant temperature.

- **Linear**
  $$\Delta T(z) = \Delta T(0) + \frac{\Delta T(L) - \Delta T(0)}{L} \cdot z$$ \hspace{1cm} (45)
  where $L$ is the grating length, $\Delta T(0)$ is the temperature at $z = 0$, and $\Delta T(L)$ is the temperature at $z = L$.

- **Gaussian**
  $$\Delta T = \Delta T_0 \cdot \exp\left\{- \ln 2 \cdot \left[ \frac{2 \cdot (z - L/2)}{w \cdot L} \right]^2 \right\}$$ \hspace{1cm} (46)
  where $\Delta T_0$ is the peak temperature value and $w$ is the normalized value of FWHM.

Other temperature distributions can be defined by user functions.

**Grating Device Characteristics**

**Reflection**

Reflection at a given position is defined by the ratio of back-reflected power to input power:

$$R = \frac{P_B}{P_{IN}} \quad P_B - backward \ power \quad P_{IN} - input \ power$$ \hspace{1cm} (47)
The program calculates reflection for both coupled modes, called Reflection 1 and Reflection 2 respectively.

- For Propagation calculations, the reflection is obtained at every point along the grating device. In the case of multiple gratings, the device begins with the first grating and ends with the last grating:

\[ R = P_B(z) \quad 0 \leq z \leq \text{end of device} \quad \lambda = \text{const} \quad (48) \]

- For Spectrum calculations, the reflection is obtained at the end of the device:

\[ R = \frac{P_B(\lambda)}{P_{IN}(\lambda)} \quad z = 0 \quad \lambda \in (\lambda_{min}, \lambda_{max}) \quad (49) \]

Transmission

Transmission at a given position is quantified by the ratio of forward-carried power to input power:

\[ R = \frac{P_F}{P_{IN}} \quad P_F - \text{forward power} \quad P_{IN} - \text{input power} \quad (50) \]

The program calculates transmission for both coupled modes, called Transmission 1 and Transmission 2 respectively.

- For propagation calculations, the transmission is obtained at every point along the grating device. In the case of multiple gratings, the device begins with the first grating and ends with the last grating:

\[ R = P_F(z) \quad 0 \leq z \leq \text{end of device} \quad (51) \]

- For spectrum calculations, the transmission is obtained at the end of the device:

\[ R = \frac{P_B(\lambda)}{P_{IN}(\lambda)} \quad z = \text{end of device} \quad \lambda \in (\lambda_{min}, \lambda_{max}) \quad (52) \]

Cumulative Phase

Cumulative Phase is the phase change of the electromagnetic field accumulated for a given wavelength.
CHAPTER 2: TECHNICAL BACKGROUND

Group Delay

Group Delay is the first derivative of the cumulative phase with respect to the angular frequency.

\[ T_g = \frac{d\Psi}{d\omega} = \frac{d\Psi}{d\lambda} \frac{d\lambda}{d\omega} = -\frac{\lambda^2}{2\pi c} \frac{d\Psi}{d\lambda} \quad \Psi = \text{cumulative phase} \quad (53) \]

Dispersion

Dispersion is defined as the first derivative of the group delay with respect to the wavelength.

\[ D(\lambda) = \frac{dT_g}{d\lambda} = -\frac{\lambda^2}{2\pi c} \left[ \frac{d^2\psi}{d\lambda^2} + \frac{2}{\lambda} \frac{d\psi}{d\lambda} \right] \quad (54) \]

The Inverse Scattering Problem

The reconstruction method uses a layer peeling algorithm, a complete description is found in reference [1]. This method can be implemented after the problem is approximated by a series of discrete layers, each with a constant coupling coefficient. At the beginning of the problem, all these coupling coefficients are unknown. The method uses an iterative approach, in which the first N layers of the profile are assumed known, and in the next iteration, the coupling coefficient for the N+1 layer is deduced. The layers are chosen to be of uniform width so that the time it takes for a wavefront to cross any layer is a constant, \( \Delta \). The method uses the fact that the impulse response at the time \( 2(N+1)\Delta \) must be independent of all the layers following the layer N+1. By the property of causality the impulse response at this instant must be independent of the coupling coefficients to be found in the layers N+2, N+3, and so on. On the other hand, the coupling coefficients in the first N layers are assumed known, so by solving the scattering problem with these N layers, the impulse response for a grating truncated at the Nth layer can be found. Furthermore, the truncated impulse response from the first N+1 layers can be found if only the single coupling coefficient at N+1 were known. The truncated impulse response is then compared to the desired impulse response at time \( 2(N+1)\Delta \). By choice of a suitable value of coupling coefficient in the N+1 layer, the impulse response of the truncated grating can be made the same as the desired impulse response, from time 0 up to time \( 2(N+1)\Delta \). In this way the coupling coefficients in the first N layers are used to find the coefficient in the N+1 layer. The unknown layers are “peeled” from the grating one at a time.
CHAPTER 2: TECHNICAL BACKGROUND

Technical References

You will find below a list of general references relevant to waveguide and fiber gratings and to waveguide optics. Optiwave Corporation does not endorse any of the references, nor do the OptiGrating algorithms follow exactly the publications. The references are listed for your convenience:

General books about waveguides and fibers

General books about Fiber Bragg gratings

Articles about the Coupled Mode Theory

Transfer Matrix Method

Fiber and Waveguide Gratings
CHAPTER 2: TECHNICAL BACKGROUND


Pulse Response of Grating

Fiber Grating Sensor

Inverse Scattering Problem

Mode Solver
CHAPTER 3: THE OptiGrating TUTORIAL

Tutorial

The best way to learn how to work with OptiGrating 4.2 is to do the Tutorial lessons. By following the step-by-step instructions, you will see how quickly you can become a highly efficient OptiGrating user.

Although you can use OptiGrating to perform a huge variety of tasks, in these introductory lessons you will learn how to design a Fiber Bragg grating, how to work with Sensors, and how to define Material Dispersion.

Lesson 1 : Designing a Fiber Bragg Grating

In the first lesson, you will learn how to design a Fiber Bragg Grating with chirp and apodization. Such a grating finds application in fiber dispersion compensation.

Step 1

The first thing you will do is to open a new project. Then, you will choose one of the five available modules to work with: Single Fiber, Fiber Coupler, Single Waveguide, Waveguide Coupler, and Other Waveguide.

To select the Single Fiber Module

1. File > New.
2. In the New dialog box, click the Single Fiber option.

Note: You can also open a new project by clicking the New button on the Toolbar.

Step 2

Next, you will define certain parameters for the Single Fiber. You will do that in the Single Fiber dialog box in which you can set the following characteristics: Index Profile, Photosensitivity Profile, Number Of Points In Mesh, Central Wavelength, etc.

To open the Single Fiber dialog box

1. In the Project Window, click the Fiber/Waveguide Parameters button.
The Single Fiber dialog box appears on the screen.

Note: Since you are going to use the default parameters, you don’t have to change any of the predefined options.

2. Click OK to close the Single Fiber dialog box.
Step 3

In this step, you will access a list of the calculated modes of your Fiber/Waveguide structure. The fiber you use is a single mode fiber.

To see a list of the calculated modes

1. From the Parameters Menu, click Mode.
2. Make sure that the Input Amplitude is set to 1 and the Phase is set to 0.
3. Click the OK button.
Note: If you have chosen to work with the Single Fiber module or the Single Waveguide module, you will see that there is only one list of modes in the Modes dialog box. If you are working with other modules, you will see that there are two lists available in the dialog box.

Step 4

In this step, you will learn how to open the Grating Manager dialog box and how to access the Grating Definition dialog box in which you can define the parameters of each grating. The Grating Manager gives you a list of your grating objects (and some important information about those objects) and allows you to add, remove, or copy gratings or phase shifts.

To open the Grating manager dialog box

1. From the Parameters Menu, click on the Grating...
2. In the Grating Manager dialog box, double-click the Grating 1 object to open the Grating Definition dialog box.

Note: To open the Grating Definition dialog box, you can also click the Edit Item button.

Step 5

In this step, you will define the parameters of the grating you’re working with in the Grating Definition dialog box.

To define the grating’s parameters

![Grating Definition dialog box](image)
1. In the Grating Definition dialog box, from the Grating Shape list box, choose Sine.
2. From the Average Index dialog box, choose Uniform.
3. In the Index Change box, make sure the index is set to 0.
4. From the Period Chirp list box, choose Linear.
5. In the Total Chirp box, type 2.
6. From the Apodization list box, choose User Defined.
7. In the Ind. Mod. box, type 0.0006.
8. In the Number of Segments box, type 101.

**Note:** You will notice that for some of the parameters you can use either the predefined functions or the User Defined options. Notice that when you choose the User Defined option from the Apodization list box, the Define button is enabled.

- The grating will be defined by the number of segments entered in the Number Of Segments box. All segments will be treated as a single uniform grating. Better precision is available by increasing the number of the segments. However, calculation time increases with the number of segments.
- All grating parameters are fully described in the Technical Background section.

**Step 6**

In this step, you will learn how to program functions in the User Defined dialog box. The User Defined dialog box allows you to program functions by using Basic syntax and to test visually the function by pressing the Display button. At the end of this step, you will have defined all the necessary parameters for the Fiber Bragg grating.

**To program and test functions**

1. In the Grating Definition dialog box, click the enabled Define button (next to the Taper’s Parameters option).

   ![Taper's parameter: Define](image)

2. In the User Defined Function dialog box, delete everything from the Edit window (where you have a function already defined by default) and write the following function:

\[ w = 0.7 \exp \left( -\frac{2 \times (x\text{-}Length/2)}{(Length\times w)^4} \right) \]
Click the Display button to see a new curve with the parameters you have defined in the Grating Definition dialog box.

**Note:** When you change the value of “w” and click the Display button, you will see a different curve. You may want to experiment with different values before closing the User Defined Function dialog box.

- Anything written on a line after the // command is ignored.

**4** Click the OK button to close the User Defined Function dialog box.

**5** In the Grating Definition dialog box, click the OK button.

**6** In the Grating Manager dialog box, click the OK button to return to the Project Window.
Step 7

Having defined all the necessary parameters for the Fiber Bragg grating, you will now learn how work in the Multiple View window.

In the Project Window, you have access to different Parameter buttons, displayed on the left side of the Project Window. You can choose from several Calculation options, listed in the Calculation list box; you can use the color button, placed on the small Toolbar; and you can use the Display tabs, placed at the bottom of the Graph window.

To see the calculation results

1. From the Calculation list box, choose Propagation.
2. In the Propag. step edit box, type 500
3. Click the Calculate button to see the results.

![Graph showing intensity vs. length.](image)

To use the color buttons

1. Click anywhere in the Graph window.
2. On the small toolbar, press the Red button to see the Transmitted Power curve.
3. Press the Blue button to see the Reflected Power curve.

*Note:* Each color represents a different curve. In the example above, only two color buttons can be enabled because there are only two curves available.

- On the small toolbar that contains the color buttons, you can click the first gray/white button to hide the Calculated options window and the Parameter buttons.
Step 8
There are several Display tabs available in the Multiple View window. Each tab represents a different graph. Depending on the Module you are using and the options you have chosen, some of the tabs may be disabled. For example, the 3D Display tab is enabled only when you are performing a Propagation calculation.

To use the Display tabs
1. In the Project Window, click in the Graph window.
2. Click the 3D Display tab.
3. In the Graph window, click the right mouse button to see the pop-up menu.

*Note:* The pop-up menu allows you to use several commands: Crosssection Monitor (to see across sections), Display Properties, and Print Graph.
Step 9

In this step, you will learn how to use the different calculation options and how to do simple calculations. For this purpose, you will use the calculation options in the Calculation list box that contains the most often used calculation options.

To Calculate spectral characteristics

1. In the Multiple View window, click the Power tab.
2. From the Calculation list box, choose Spectrum.
3. Select wavelength range from 1.545um to 1.555um, and set the Steps to 500.
4. Press the Calculate button to calculate the spectral characteristics.
5. Right click on the graph.
6. From the list, choose Axis Properties.
7. Select the Left Y axis tab, then deselect the Show as dB box.
8. Click OK. The graph will change automatically.
**Note:** Notice that the parameters in the Calculation section change according to the option you have chosen from the Calculation list box.
Step 10
OptiGrating allows you to measure automatically full width at half maximum. To do so, in this step you will use the FWHM tool.

To use the FWHM tool

1. Click once on the display window. Select the Reflection curve by clicking the red button on the tool bar.
2. Right click on the graph.
3. From the list, choose Axis Properties.
4. Select the Left Y axis tab, then deselect the Show as dB box.
5. Click OK.
6. Select FWHM from the Tools drop down menu to display the 'Tools' dialog box.
7. In the Tools dialog box, to calculate the bandwidth at half of the maximum, select the At check box beside bandwidth.
8. Enter 0.5 in the box next to the At check box.
9. Click Recalculate.
10. Click the Close button to close the dialog box.

Note: In the Tools dialog box, you can calculate not only the bandwidth at half of the maximum; if you enable the At check box, you can enter any desired y-axis absolute position in the box and click the Recalculate button.
CHAPTER 3: THE OPTIGRATING TUTORIAL

- If the blue line showing bandwidth is not horizontal, you have to calculate more points, i.e. you have to increase the number of steps in the Steps box.
- You can also close the Tools box, go back to the Project Window, click another color button to display a different graph, and apply the FWHM command to it.

Step 11

In this step, you will see the Cumulative Phase graph, the Delay graph, and the Dispersion graph.

To see the Cumulative Phase graph

1. In the Project Window, type 1.54784 in the From box.
2. In the To box, type 1.5522.
3. In the Steps box, type 800.
4. Make sure both the Reflection and Transmission buttons are selected.
5. Click the Calculate button.
6. In the graph window, click the Phase tab.

Note: By default, the Phase is cumulative. To toggle between the Cumulative Phase and standard phase, double click the left mouse button and from the pop-up menu, click Cumulative Phase.
To see the Delay graph

In the Multiple view window, click the Delay tab.

To see the Dispersion graph

In the Multiple view window, click the Dispersion tab.
CHAPTER 3: THE OPTRIGATING TUTORIAL

Step 12

In this step, you will choose the Pulse Response Calculation option, define some of the Pulse Response characteristics, and do a simple calculation.

To define Pulse Response characteristics

1. Click in the graph window.
2. From the Calculation list box, choose Pulse Response. You will notice that the Define button is enabled.
3. In the Steps box, type 511.
4. In the Time Span box, type 200.
5. In the Wavelength box, type 1.55.
6. Click the Define button.
7. In the Pulse Response dialog box, from the Input Pulse list box, choose Gaussian.
8. In the Intensity FWHM box, type 10 and click the OK button.
9. In the Project Window, click the Calculate button.

Note: You do not need to enable the Link check box at this point.

Step 13

In this step, you will explore some of the graphs for Pulse Response. You can see Input Pulse, Input Spectrum, Grating Spectrum, and Output Pulse.

To view the Output graph

In the Multiple view window, click the Output tab.

To see the Profile graph

In the Multiple view window, click the Profile tab.
To see the Profile graph

In the Multiple view window, click the Profile tab.

- The Profile tab displays your grating characteristics defined in the Grating Manager and the Grating Definitions dialog boxes. You can display all characteristics separately, as a 2D graph, or combined, as a Profile graph.
- To switch between characteristics, click the right mouse button and from the pop-up menu choose the desired option.
CHAPTER 3: THE OPTIGRATING TUTORIAL

What do you see on the Profile graph?

Select Apodization

On the y-axis of the Profile graph, you see the grating Refractive Index that is determined by Apodization:

Select Profile Chirp Period

On the y-axis of the Profile graph, you see the grating period that is determined by the Grating Period Chirp:
Select Average Index

The profile is also determined by the Average Index. Since you have selected Uniform Average Index, the Profile is positioned to 1.46 as Core Refractive Index:

![Graph showing profile average index vs. grating length]

This ends Lesson 1. You may now proceed to Lesson 2 that uses the grating profile from Lesson 1. Otherwise, save your work in order to be able to do the next tutorial lesson later. To save your work, select Save As from the File menu and enter a file name (for example, Lesson1.ifo).
Lesson 2: Sensors

In this lesson, you will use the Fiber Bragg Grating example from Lesson 1. Have a look at the Profile graph.

Step 1

In this step, you will learn to define Sensor characteristics.

To define Sensor characteristics

1. Select Grating from the Parameters menu, or simply select the Grating icon on the left.
2. In the Grating Manager dialog box, double-click the selected grating to open the Grating Definition dialog box.
3 In the Grating Definition dialog box, enable the Sensors check box.
4 Click the Define button beneath the Sensors check box.

5 In the Fiber Bragg Grating Sensor dialog box, in the Temperature section, select Linear from the list box.

6 Make sure the value in the From box is set to the default value, 0 degree Celsius.

7 Make sure the value in the To box is set to the default value, 50 degree Celsius.

8 Click the OK button to close the Fiber Bragg Grating Sensor dialog box, click the OK button to close the Grating Definition dialog box, and click the OK button to close the Grating Manager.

9 Select the Profile tab from the window.

10 Click the Calculate button.

11 The spectrum for the specified temperature distribution will be calculated. Note that changing the distribution will change the spectrum.
Lesson 3 : Material Dispersion

Step 1

In this step, you will create a new project. Choose the Single Fiber Module, and define fiber parameters.

To define fiber parameters

1. On the Toolbar, click the New button.
2. In the New dialog box, click Single Fiber.
3. In the Project Window, click the Fiber/Waveguides Parameters button.
4. In the Single Fiber Profile dialog box, add three regions: Core, Cladding, and Air.

Note: The name of the region can be edited by double clicking on it.

For Core, enter the following data:

Width: 4.15
Real Index: constant
Value: 1.44921

For Cladding, enter the following data:

Width: 58.35
Real Index: constant
Value: 1.44403

For Air, enter the following data:

Width: 20
Real Index: constant
Value: 1.0
Step 2

In this step, you will define the material dispersion of the fiber core.

To define the material dispersion of the fiber core

1. In the Single Fiber Profile dialog box, Select the Enable and deselect the Global options in the dispersion section.
2. Highlight the core region, and select Define in the dispersion section.
3. In the Material dispersion dialog box, select Define in the Host section.
4. In the Sellmeier Parameters dialog box, select Pure Silica from the library and press Get, followed by pressing OK to close the Sellmeier Parameters dialog box.
box. You can see in the Material Dispersion dialog box that the host material is now Pure Silica.

5 Similarly as in the previous step, define germanium-doped silica for the Dopant+ material

6 Similarly as in the previous step, define fluorine-doped silica for the Dopant- material

Your Material dispersion dialog box should look like this:

7 Press OK in the Material Dispersion dialog box to close it.

Step 3

In this step, you will learn how to use the library of Sellmeier coefficients.

To open the Sellmeier Coefficients dialog box

1 In the Dispersion box, click the Define button.

2 In the Material Dispersion dialog box, select Define in the Host section.

3 In the Sellmeier Coefficients dialog box, highlight the Pure silica material and press the Get button. The Sellmeier coefficients in the dialog box are replaced by the Sellmeier coefficients of Pure silica

4 Click the OK button to close the Sellmeier Parameters dialog box.
Note: The Sellmeier Coefficients Library is a separate file and is common for all projects.

- You can add recently entered coefficients to the library, or you can get previously added coefficients from the library.
- Instead of writing new coefficients, all you need to do is double-click on a desired material in the library.

Step 4

In this step, you will define the material dispersion of the fiber cladding and Air.

To define the material dispersion of the fiber cladding

1. Highlight the Cladding region, and select Define in the dispersion section
2. In the Material dispersion dialog box, select Define in the Host section.
3. In the Sellmeier Parameters dialog box, select Pure Silica from the library and press Get, followed by pressing OK to close the Sellmeier Parameters dialog box. You can see in the Material Dispersion dialog box that the host material is now Pure Silica.
4. Similarly as in the previous step, define germanium-doped silica for the Dopant+ material
5. Similarly as in the previous step, define fluorine-doped silica for the Dopant- material
6. Press OK in the Material Dispersion dialog box to close it.
To define the material dispersion of the Air

1. Highlight the Air region, and select Define in the dispersion section.

2. In the Material dispersion dialog box, select Define in the Host section.

3. In the Sellmeier Parameters dialog box, select Air from the library and press Get, followed by Pressing OK to close the Sellmeier Parameters dialog box. You can see in the Material Dispersion dialog box that the host material is now Air.

4. Press OK in the Material Dispersion dialog box to close it.

*Note:* Dopant settings have no effect for Air
**Step 5**

In this step, you will select fiber modes in the Single Fiber Modes dialog box.

**To select modes**

1. From the Parameters Menu, click Mode... to open the Single Fiber Modes (multiple modes) dialog box. Here, you will see the calculated modes for the fiber defined in the previous steps.

2. In the Single Fiber Modes dialog box, select the first six modes. To do this, click the first mode, press down the SHIFT key, and click the sixth mode.

3. Click the OK button.

*Note:* In the Single Fiber Modes dialog box, you can select multiple modes.
CHAPTER 3: THE OPTIGRATING TUTORIAL

Step 6

In this step, you will define the grating parameters.

To define the grating parameters

1. In the Project Window, click the Grating Parameters button.
2. In the Grating Manager dialog box, double-click the listed grating to open the Grating Definition dialog box.

3. In the grating Definition dialog box, disable the Auto check box.
4. In the Period box, type 450.
5. From the Apodization list box choose Gaussian and in the Taper’s parameter box type 1.
6. In the Length box, type 40000.
7. In the Ind. Mod. box, type 0.0002.
8. In the Number Of Segment box, type 101.
9. Click the OK button to close the Grating Definition dialog box, and then click OK to close the Grating Manager dialog box.

Note: The grating parameters are described in detail in the “Technical Background” section.

Step 7

In this step, you will perform a Spectrum calculation and see the final result of all your efforts.
To do the calculation

1. In the Project Window, from the Calculation list box, select Spectrum.

2. In the From box, type 1.2 to set the beginning point of the calculation range.

3. In the To box, type 1.8 to set the end point of the calculation range.

4. In the Steps box, type 500 to assign many points for calculation.

5. Go to Parameters > Dispersion. Make sure the Dispersion option is checked in the Parameters drop down box.

6. Click the Calculate button.

When the Power tab is enabled and you select only the leftmost red graph button, your graph should look like this:

The graph shows the wavelengths for which the grating with period 450 µm will transfer the incident mode’s power to the other five modes.
Lesson 4: Parameter Scan

In OptiGrating, all the parameters related to the grating can be scanned with the Parameter Scan tool. It can help the user find optimized grating parameters to meet the application requirements.

In this lesson, we will simulate a grating, which has a higher order Gaussian apodization profile. The FWHM of the grating apodization function will be scanned, and the spectrum properties, such as bandwidth, sidelobe, peak value, peak position, and dispersion at central wavelength are calculated. Based on the simulation results, the optimized FWHM value for suppressing the sidelobe can be obtained.

*Note:* The simulation of the following example may take 5 to 30 minutes. It depends on the speed of your computer.

Step 1

In this step, you will learn how to define a dispersion-shifted fiber profile.

1. File > New.
2. In the New dialog box, click the Single Fiber option.
3. From the Parameters menu, click Fiber/Waveguide.
4. Delete default Regions core and cladding by highlighting them and then pressing the Remove button.
5. In the Single Fiber Profile dialog box, add four regions: Region 0 through Region 3.

For Region 0, enter the following data:

- **Width:** 3.1
- **Real Index:** user function.
  - The user function is defined as: \(1.44439*\sqrt{1+2*0.01*(1-x/\text{WIDTH})}\)
- **Radial Photosensitivity Type:** constant
- **Radial Photosensitivity Value:** 1.0
- **Steps:** 100

For Region 1, enter the following data:

- **Width:** 0.9
- **Real Index:** constant
  - **Value:** 1.44439
- **Radial Photosensitivity Type:** constant
- **Radial Photosensitivity Value:** 0.0
For Region 2, enter the following data:

Width: 1.5
Real Index: constant
Value: 1.44728
Radial Photosensitivity Type: constant
Radial Photosensitivity Value: 0.0

For Region 3, enter the following data:

Width: 20
Real Index: constant
Value: 1.44439
Radial Photosensitivity Type: constant
Radial Photosensitivity Value: 0.0

Use the default setting for other parameters.
Step 2

In this step, you will access a list of the calculated modes of the fiber. The fiber you are using is a single mode fiber.

1. From the Parameters Menu, click Mode…to open the Single Fiber Modes (multiple modes) dialog box. Here, you will see the calculated modes for the fiber defined in the previous steps.
2. In the Single Fiber Modes dialog box, select the LP(0,1) mode.
3. Click on the OK button.

Step 3

In this step, you will define the grating parameters and learn how to define scan parameters in the user-defined function.

To define the grating parameters

1. In the Project Window, click the Grating Parameters button.
2. In the Grating Manager dialog box, double-click the listed grating to open the Grating Definition dialog box.
3. In the Length box, type 40000.
4. In the Ind. Mod. box, type 0.0002.
5. In the Number Of Segment box, type 250.
6. From the Apodization list box choose user defined, and press the Define button.
In the edit window of the User Defined Function dialog box, define the user defined function as:

```plaintext
//Higher order Gaussian function
//m is the order of higher order Gaussian function
//w is the FWHM of the higher order function
m=4;
SCANdefault = 0.5;
w=Length*SCAN;
temp=2*( pow(ln(2),(1/m)));
exp( -(temp*(x-Length/2)/w)^m );
```

where the SCAN parameter is the normalised FWHM of the apodization function.

Click the OK button to close the Grating Definition dialog box, and then click OK to close the OK button to close the Grating Manager dialog box.

**Note:** The SCANdefault and SCAN are the key words in the user-defined function. When you do Scan Calculation, the value of SCAN is changing. For other calculations (Propagation, Spectrum, Pulse Response), the value of SCAN is equal to the value of SCANdefault.
Step 4

In this step, you will perform a Spectrum calculation. The SCAN value is equal to the SCANdefault value.

1. In the Project Window, from the Calculation list box, select Spectrum.
2. In the From box, type 1.5496 to set the beginning point of the calculation range.
3. In the To box, type 1.5504 to set the end point of the calculation range.
4. In the Steps box, type 1000 to assign many points for calculation.
5. Click the Calculate button.
6. Right click on the graph and choose Axis Properties.
7. Select the Left Y axis tab and then deselect the Show as dB check box.
8. Click OK.

When the Power tab is enabled, your graph should look like this:

![Graph Image]

*Note:* This step is important for the Scan calculation. The parameters set in this step will be used in the Scan calculation. Choose proper From, To and Steps parameters, so that the calculated spectra peaks are located around the center of the calculation window.
**Step 5**

In this step, you will perform a Scan calculation and see the final results.

1. From the Calculation menu, select Scan.

2. In the Scan dialog box, select User Variable 'SCAN' in the Select Scan Parameter section.

3. In the From box, type 0.2 to set the beginning value of the scanning parameter.

4. In the To box, type 1.0 to set the ending value of the scanning parameter.

5. In the Steps box, type 50 to set the calculation steps.

6. In the Calculate Bandwidth at box, type –3, and enable the dB check box.

7. Press Calculate button.

8. After the Calculation is done, click the Scan tab in the Multiple View window.

9. By double clicking on the Scan graph, you can display Bandwidth, Sidelobe, Peak value, Peak position, and Dispersion at Central Wavelength.
Enable the bandwidth check box in the Display Selection dialog box. You will see the results show Bandwidth vs. Scan Parameter. When the FWHM of the apodization function increases, the effective length of the grating increases, and the bandwidth will decrease.

Enable the Sidelobe check box in the Display Selection dialog box. You will see the results show sidelob vs. Scan Parameter. The results show the optimized FWHM for suppressing sidelobe is 0.712. In this case, the sidelobe reaches a minimum value of 0.0105.
Enable the Peak value check box in the Display Selection dialog box. You will see the results show peak value vs. Scan Parameter. When the FWHM of the apodization increases, the index modulation along the grating increases, so the peak value (maximum reflectivity) will increase.

Enable the Peak position check box in the Display Selection dialog box. You will see the results show peak position vs. Scan Parameter. During the parameter scan calculation, the grating period is a constant; so peak position (Central wavelength) is not changing with the scan parameter.
Enable the Dispersion at Central Wavelength check box in the Display Selection dialog box. You will see the result shows dispersion vs. Scan Parameter.
Lesson 5: Synthesis of a Band Pass Filter

Step 1

1. Open a new project with File > New > Single Fiber.
2. Calculation > Inverse Scattering Solver, to get Inverse Problem Solver dialog box.
3. Select User Defined frame checkbox.
4. Enter the starting and ending wavelengths, and the number of steps in the User-Defined frame as shown.

- The Steps field indicates the number of divisions used in the specified wavelength range.
5  In the Length field, enter the length of the grating, 5 cm (50,000 µm).

6  In the Segments field, enter the number of segments to be 1000, this is the number of segments that will have constant coupling coefficients within them. The layer peeling algorithm will use 1000 layers in this case.

7  Enter 4 in the Over Sample field. Over Sample is used in the reconstruction of the truncated impulse response, the accuracy is sometimes improved by using finer steps in the spectrum.

8  Click on the Define button next to the Ref/Trans.

This brings up a dialog box for defining the reflectivity spectrum as seen below:

9  Next, type in the text as shown in the screen above.

10 Click on Display to plot the curve shown. The desired impulse response will be calculated from the Fourier transform of this reflection coefficient.

11 Click OK.

12 Click on the Disp button in the Inverse Problem Solver dialog box. This means that we will define the phase response by specifying dispersion.

13 Click on the adjacent Define button to define the dispersion profile. This will produce the following results:
• Here the dispersion returned is 0 for all wavelengths in the range.

14 Click OK.
Step 2

1. Click on the Causality button in the Inverse Problem Solver dialog box. This will display the impulse response calculated from the spectrum you have defined.

- Because of causality, any real impulse response must be zero for negative arguments. In this picture some unphysical oscillations are seen in the negative domain. These oscillations will cause inaccuracies in the reconstruction. They can be reduced by adding delay to the response (a linear phase shift).

**Note:** You can experiment with various delays by entering other numbers in the Linear Phase Shift field, and clicking Impulse Response to see the result.

2. Click on Close.

3. Click on Start in the Inverse Problem Solver dialog box to start the reconstruction. A progress bar indicates the progress of the layer peeling algorithm. When this process finishes, the reconstructed grating profile is used to generate the spectrum of the new grating. A second progress bar displays the progress of the calculation of the spectrum.

4. Select the Power tab to see the spectrum of the new grating.
The realised Reflectivity is shown in light blue, and the desired reflectivity in dark blue. The Transmission is shown in red.

Select the Dispersion Tab to show the realised versus the desired dispersion.

- Within the reflection band, where significant power is reflected, the dispersion is close to the desired value. The dispersion outside the reflection band comes from the very small reflection in this spectral range, and the desired response is lost in numerical noise.
Select the Profile tab to see the actual grating which generated this spectrum.
Lesson 6: Reconstruction of Unknown Grating from Reflection Coefficient

In this lesson we check that the layer peeling algorithm can reconstruct an unknown grating with knowledge of only the reflection coefficient. In the first step, we select a typical grating with chirp and apodization and calculate its reflection coefficient. This spectrum is then exported to a text file. In the next step, OptiGrating is run again and the spectrum file imported. The layer peeling algorithm is applied to the imported spectrum to reconstruct the original grating.

Step 1
1. File > Open. Choose file Ex1a.ifo.
2. Select the Profile tab to see the details of this grating.

- It has a linear chirp of 0.2 nm, and a gaussian apodization with FWHM = 0.5.
3. Select the Power tab to see the reflection and transmission spectra.
Note: You can press Calculate to calculate the spectrum again, if desired.

4 Click on Spectrum in the Single Fiber drop down menu, then click on the graph in the main window to active it.

5 Select Tools > Export Complex Spectrum and select the Reflection button as shown below:
6 Click Export.
7 In the Save As dialog box, find a suitable place and name for your data file.
8 Close Ex1a.ifo.

Step 2
1 Now, open a new project with File > New > Single Fiber.
2 Choose Calculation > Inverse Scattering Solver to get the Inverse Problem Solver dialog box.
3 Select the From File checkbox.
4 Navigate to the place where you left the file with the reflection spectrum. Open the file.

5 We suppose that the original length of the grating is known, so enter 50000 µm in the Length box. (Feel free to experiment with different lengths.)
   • The original spectrum was generated with a profile having 100 segments. It is not necessary that the reconstruction have the same number, here it is set to 1000.
Click on the Causality button to test this spectrum.

Since this spectrum was generated from a real grating, it displays exactly the causal property of being zero for negative argument.

Click Close.

Click Start in the Inverse Problem Solver dialog box to begin the reconstruction.

Click on Spectrum to enable all tabs.

Select the Profile tab to see the reconstructed profile.
• The apodization appears to be a similar shape as the original grating.

To see the chirp more clearly, right click the mouse in the Profile window and select Chirp Period.

... to get the following:
• The chirp is linear and shifts by 0.2 nm, like the original grating.

Select the Power tab to compare the reflectivities, one from the imported complex spectrum and the other from the calculated response of the reconstructed grating.
Lesson 7: Synthesis of a Grating for Dispersion Compensation

Step 1

1. Open a new project with File > New > Single Fiber.
2. Choose Calculation > Inverse Scattering Solver to get the Inverse Problem Solver dialog box.

3. Set the From and To wavelength fields to 1.5498 and 1.5502.
4. Set the grating length at 20 cm in the Length field.
Click on the Ref/Trans Define button to define the reflection spectrum.

```plaintext
5W = 0.0004;
IF x>Lambda0-5W/2 E x<Lambda0+5W/2 THEN
RETURN 0.90
ELSE
RETURN 0.0
```
6 Set the bandwidth to 0.4 nm and the reflectivity to 0.9 within this band.

7 Click OK.

8 Select the Disp radio button and click the adjacent Define button to define the dispersion spectrum.

9 In this screen, set the dispersion to -1800 ps/nm for all wavelengths, as seen above.

10 Click OK.
11 Click the Causality button to see the impulse response of the specified spectrum.

12 Click Close.
CHAPTER 3: THE OPTIGRATING TUTORIAL

Step 2

1. Click Start in the Inverse Problem Solver dialog box to start the layer peeling algorithm.
2. Select the Delay tab.
3. Select the red and light blue curves to show the transmitted and reflected delays. The dark blue curve shows the target delay.
4. Click in the graph window and go to Tools > Group Delay

- The window displays the reconstructed group delay with a second order fitting. The dispersion is reported in the Results frame as -1773.79 ps/nm, in close agreement with the desired response.
Lesson 8: Synthesis of a Filter with User-Defined Spectrum

In this lesson we show an example of the synthesis of a filter with an arbitrary user defined spectrum. In this example, we ask for a bandpass filter having a reflection coefficient with a linear variation of amplitude (the reflectivity has a square root variation).

Step 1

2. Then select Calculation > Inverse Scattering Solver, to get Inverse Problem Solver dialog box.
3. In the Inverse Problem Solver box, make sure the User-Defined checkbox is checked.
4. Enter the starting and ending wavelengths, and the number of Steps in the User-Defined frame as shown.
5 Click on the Define button next to the Ref/Tran and enter the formula shown below to define the reflectivity.

6 Click OK.

7 Select the Disp button.

8 Click on the adjacent Define button to define the dispersion.
Click OK.
CHAPTER 3: THE OPTIGRATING TUTORIAL

Step 2

1. Click on Start to reconstruct the grating.
2. Select the Power tab at the bottom of the screen to see the reflected and transmitted power.
3. Right click the mouse in the graph window to pull down the menu and select Axis Properties.
4. Select the Left Y axis and uncheck the Show in dB box to show the reflection in a linear scale.
5. Click OK.
Examples

The rest of the Tutorial offers you eight selected examples that you can find in the \Samples directory. The \Samples directory contains even more examples that are not described here. You can always have a look at them and read their description by selecting the Memo tab.

Example 1: FBGApod.ifo

Apodized Fiber Bragg Grating Simulation

Reference


Description

The example demonstrates the effect of apodization on the optical properties of a fiber grating. A chirpless, sinusoidal Bragg grating has a user-defined average refractive index and apodization.

The average index is modulated by the Gaussian function:

\[
\text{Index}_\text{Mod} \cdot \exp\left(-\ln2 \cdot (2 \cdot (x-\text{Length}/2)/\text{Length})^2\right)
\]

The fiber Bragg grating is apodized by the Gaussian function:

\[
\exp\left(-\ln2 \cdot (2 \cdot (x-\text{Length}/2)/\text{Length})^2\right)
\]

where the variable \(x\) is the propagation distance along the fiber.
The main results are the reflection and group delay spectra. Both spectra show a considerable suppression of sidelobes.

Peaks at the shorter wavelength are caused by the non-uniform DC average index change.

Example 2: SuperStructure.ifo

**Sampled grating**

**Reference**


**Description**

The example demonstrates a sampled grating exhibiting periodic superstructure. The superstructure is a collection of 99 identical gratings and phase shift blocks. The gratings are uniform and have a uniform average index.
The main result is the multi-peak, periodic superstructure of the reflected power spectrum. If the phase shift blocks were replaced by the gratings, thus producing a single uniform grating, the resulting spectrum would have a well-known single-lobe shape (with ripples due to the grating uniformity). That single-lobe spectrum would be much narrower than the superstructure spectrum.

**Example 3: ModeConversion.info**

**Mode Conversion by Fiber Bragg Grating**

**Reference**

**Description**
The example demonstrates the mode conversion between the LP01 and LP02 mode in a fiber with Bragg grating. The fiber has four LP core modes. In the example, only three core modes, LP01, LP02, and LP11, are selected for calculations. The grating period, 0.21436546 microns, allows the coupling between the forward propagating LP01 mode and the backward propagating LP02 mode.

The main results are the narrow reflection and transmission spectra showing the conversion of selected modes.
Note: For this example, the file includes all the design data and the calculation results.

Spectrum

The left-hand side peak is the mode conversion from LP01 mode to backward LP02. The right hand side peak is the coupling between LP01 mode to its backward mode.

Set the grating tilted angle to 3.0 degrees and click the Calculation button again.

Spectrum with tilted angle of 3.0°

The peak at the middle is the mode conversion from the LP01 mode to the backward LP11 mode.

Example 4: WBGTransmission.ifo

Phase-shifted Bragg Grating Filter Based on Planar Waveguide

Reference

Description

The example demonstrates an InP/InGaAsP planar waveguide filter. The design is based on five gratings and four phase shifts. The uniform, rectangular-shaped gratings are placed on the top of the waveguide. The phase shift regions of different length separate the gratings. The phase shifts, provided by the phase shift regions, are 0.5, 1.5, 2.5, and 3.5 p, at the central wavelength.

The main result is the transmission spectrum. It shows that the properly chosen locations and magnitudes of the phase shift regions can tailor the spectrum into a nearly rectangular shape.

Example 5: LPGGainFlat.ifo

Long-period Fiber Grating for Gain Flattening

Reference


Description

The example demonstrates a fiber grating filter used to equalize the gain of a fiber amplifier. The LP01 fiber core mode is coupled to the LP08 cladding mode. A two-grating structure is present in the fiber. The gratings are uniform and have different period.

The main result is the transmission spectrum of the fiber grating filter. The spectrum is very close to the inverted gain spectrum of the Erbium doped amplifier. Consequently, gain flattening can be achieved by introduction of such a filter after the amplifier section.
Example 6: PulseUltrshort1.ifo

Pulse Reshaping by Uniform Fiber Grating

Reference


Description

The example demonstrates a transform-limited Gaussian pulse reflected from uniform fiber gratings. The gratings have different index modulation values. You can change the grating modulation index and compare the calculated results with the published reference.

1 Index modulation = 4.356e-5. Click the Calculation button and compare the result (Pict 1) with Fig 1(a) from Reference.

2 Index modulation = 11.616e-5. Click the Calculation button and compare the result (Pict 2) with Fig 1(b) from Reference.

3 Index modulation = 4.356e-4. Click the Calculation button and compare the result (Pict 3) with Fig 1(c) from Reference.

4 Index modulation = 1.452e-3. Click the Calculation button and compare the result (Pict 4) with Fig 1(d) from Reference.
The main result is reshaping the reflected pulse. As the grating strength increases, there is a separation of the reflected pulse into two distinct components.
Example 7: PulseUltrshort2.ifo

Pulse Reshaping by Apodized Fiber Gratings

Reference

Description
The example demonstrates a transform-limited Gaussian pulse reflected from apodized fiber gratings. The gratings are apodized by a Gaussian function and the same index modulation value of $4.356 \times 10^{-4}$.

You can change the average index option and compare the results with the published reference as follows:

1. **User Defined Average Index**: $\text{Index}_\text{Mod} \times \exp\left(-\left(2\left(\frac{x-\text{Length}/2}{0.5/\text{Length}}\right)^2\right)\right)$. Click the Calculation button and compare the result (Pict 1) with the type A profile of Fig 5(b) from the Reference.

2. **Uniform Average Index with Index Change 0**. Click the Calculation button and compare the result (Pict 2) with the type B profile of Fig 5(b) from the Reference.
The main result is reshaping of the reflected pulse. The structure of the reflected pulse from the type B grating profile contains considerable regular oscillations, not present in the type A profile.

![Graph 1](Image)

*Pict 1*

![Graph 2](Image)

*Pict 2*
Example 8: MoireGrating.ifo

In-Fiber Moiré Gratings

Reference

Description
The example demonstrates how to simulate the Moiré passband filter with a chirped and apodized Bragg grating.
The grating has a user defined period chirp defined by the following:

\[ p_1 = 0.53082192 \]
\[ p_2 = 0.5309589 \]
\[ \text{chirp} = -1.1 \times 10^{-3}/\text{Length} \]
\[ \text{per1} = p_1 + \text{chirp} \times (x - \text{Length}/2) \]
\[ \text{per2} = p_2 + \text{chirp} \times (x - \text{Length}/2) \]
\[ 2 \times \text{per1} \times \text{per2} / (\text{per1} + \text{per2}) \]

where the last line defines the chirp.
The user defined grating apodization is:

\[ p_1 = 0.53082192 \]
\[ p_2 = 0.5309589 \]
\[ \text{chirp} = -1.1 \times 10^{-3}/\text{Length} \]
\[ \text{per1} = p_1 + \text{chirp} \times (x - \text{Length}/2) \]
\[ \text{per2} = p_2 + \text{chirp} \times (x - \text{Length}/2) \]
\[ 2 \times \cos(\pi \times (1/\text{per1} - 1/\text{per2}) + \pi/2) \]

where the last line defines the apodization.
The main result is the transmission spectrum of the grating.
CHAPTER 4: USER GUIDE

The File Menu

When you start OptiGrating, you have only three menus to work with: File, View, and Help. However, when you create a new project or open an existing one, you notice that there are nine menus that contain all commands you will need to do your work effectively.

The File menu, shown on the left, allows you to use the following commands:

- **New**
  Opens a new project. After selecting the New option, you have the following choices: Single Fiber, Fiber Coupler, Single Waveguide, Waveguide Coupler, and Other
  Waveguide.

- **Open...**
- **Close**
- **Close All**
- **Save**
- **Save As...**
- **Save Workspace...**
- **Save Template...**
- **Print Setup...**

When you start OptiGrating, you have only three menus to work with: File, View, and Help. However, when you create a new project or open an existing one, you notice that there are nine menus that contain all commands you will need to do your work effectively.

The File menu, shown on the left, allows you to use the following commands:

- **New**
  Opens a new project. After selecting the New option, you have the following choices: Single Fiber, Fiber Coupler, Single Waveguide, Waveguide Coupler, and Other
  Waveguide.

- **Open**
  Opens an existing project.

- **Close**
  Closes the active project. The program prompts you to save changes before closing the project.

- **Close All**
  Closes all open projects.
Save
Saves the active project under the current name and in the default location.

Save As
Saves the current project with a different name and in a location of your choice.

Save Workspace
Saves all the information in the multiple graph windows, together with the settings and the size and position of the windows.

Save Template
Saves the active project, with all its settings, as a template and allows you to apply that template to other projects.

Print
Prints the selected graph.

Print Preview
Gives you a print preview of the selected graph.

Print Setup
Allows you to set up the printer, the page size and orientation, and offers you other printing options.

Exit
Allows you to exit the program. The program prompts for saving changes to the projects.
New

File: New

Using the New Command

The New command gives you access to the five different modules you can work with in OptiGrating: Single Fiber, Fiber Coupler, Single Waveguide, Waveguide Coupler, and Other Waveguide. Those five modules have some common parameters, but you use each module for different purposes.

The Single Fiber module is the most complex one. You use this module when you want to calculate Material Dispersion and when you want to simulate the coupling between multiple modes.

When you work with Sensors (Fiber Bragg and Long Period Gratings), you can only use the Single Fiber modules.

**Note:** The differences between the five modules are best revealed in the different options available in the Fiber/Waveguide dialog box.

To start a New project

From the File menu, click New.

6 In the New dialog box, choose one of the following modules: Single Fiber, Fiber Coupler, Single Waveguide, Waveguide Coupler, or Other Waveguide.
CHAPTER 4: USER GUIDE

Single Fiber

File: New > Single Fiber

The Single Fiber Module

You use the Single Fiber module to model a fiber with arbitrary radial symmetry while the grating can be placed anywhere in the fiber. OptiGrating allows you to adjust both the fiber dimensions and refractive index profile and photosensitivity profile.

![Diagram of a fiber with a Bragg grating](image)

You can simulate the grating assisted coupling between forward and backward propagating modes. There are two mode options available: LP modes or full, vector modes (HE, EH, TE, or TM) of the fiber. The vector mode option is only available for step-index fiber. The Single Fiber module finds application in WDM selective and add/drop filters, dispersion compensators, long period fiber grating filters for EDFA gain flattening, and sensors.

To choose the Single Fiber module

1. File > New.
2. In the New dialog box, click Single Fiber.

The Single Fiber Profile Dialog Box

In this dialog box, you enter the main data concerning the fiber dimensions: index profile and photosensitivity profile.

To open the Single Fiber dialog box

1. In the Project window, click the Fiber/Waveguide Parameters button.

The Single Fiber Profile dialog box options are described below.
List of Regions
Shows the index radial regions by their names.

Add
Adds a region to the bottom of the list.

Insert
Adds a region immediately under the highlighted point on the list

Remove
Deletes the selected region from the list

Undo
Left undo arrow deletes previous steps. Right redo arrow replaces deleted steps.
CHAPTER 4: USER GUIDE

**Up**
Moves the selected region one position up the list.

**Down**
Moves the selected region one position down the list.

**Width**
Enter the width of the selected region in microns.

**Steps**
Enter the number of steps for discretization of the index profile function.

**Index tab**

**Real**
Select one of the following options for the real index profile within the current region:
Constant - Constant value of the real refractive index
Linear
Parabolic
Gaussian
Exponential
Alpha-peak
Alpha-dip
User Function - Functional dependence of the index, where the function is defined or programmed using the powerful Script Language environment.

The notation convention for these functions is described in the Technical Background, section Index Profile of Fibers. Conventionally, the functions’ argument is the radial local distance that is zero at the beginning of the region and is equal to the Width value at the end of the region.

**Value (for Real Index)**
Numerical data entry box - Present when the constant real index option is selected. Enter the real refractive index value for the selected region.

**Define (for Real Index)**
Present when the Function or User Function option is selected. Press the Define button to specify the function. For the built-in functions, a dialog box related to one of the predefined functions appears. For the User Function option, pressing the Define button launches the User Defined Function script programming environment.
Imag.
This option is available when the Real Profile check box is unchecked.
Select one of the following options for the imaginary index profile within the current region:
Constant - Constant value of the imaginary refractive index
Linear
Parabolic
Gaussian
Exponential
Alpha-peak
Alpha-dip
User Function - Functional dependence of the index, where the function is defined or programmed using the powerful Script Language environment.

Value (for Imag. Index)
Numerical data entry box - Present when the constant imaginary index option was selected. Enter the imaginary refractive index value for the selected region.

Define (for Imag. Index)
Present when the Function or User Function option was selected. Press the Define button to specify the function. For the built-in functions, a dialog box related to one of the predefined functions appears. For the User Function option, pressing the Define button launches the User Defined Function script programming environment.
Radial Photosensitivity tab

<table>
<thead>
<tr>
<th>Index</th>
<th>Radial Photosensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Value</td>
</tr>
</tbody>
</table>

**Type**

Select one of the following options for the radial photosensitivity profile within the current region:
- Constant - Constant value of radial photosensitivity
- Linear
- Parabolic
- Gaussian
- Exponential
- Alpha-peak
- Alpha-dip
- User Function - Functional dependence of the sensitivity, where the function is defined or programmed using the powerful Script Language environment.

**Value**

Numerical data entry box - Present when the constant radial photosensitivity option is selected. Enter the radial photosensitivity value for the selected region. See the definition of photosensitivity in the technical background section.

**Define**

Present when the Function or User Function option is selected. Press the Define button to specify the function. For the built-in functions, a dialog box related to one of the predefined functions appears. For the User Function option, pressing the Define button launches the User Defined Function script programming environment.

**Azimuthal Photosensitivity**

Select one of the following options for the azimuthal radial photosensitivity profile
- Constant - Constant value of radial photosensitivity
- User Function - Functional dependence of the sensitivity, where the function is defined or programmed using the powerful Script Language environment.

**Value**

Numerical data entry box - Present when the constant Azimuthal photosensitivity option is selected. Enter the Azimuthal photosensitivity value for the fiber.

**Steps**

Enter the number of steps for discretization of the Azimuthal photosensitivity profile user function.
Note: The ‘x’ variable in the user defined function is the azimuthal angle from 0 to 2p.

Dispersion Enable
Enable the material dispersion model for the current region. The model definition can be accessed by pressing the Define button in the Dispersion section of the dialog box (see Material Dispersion dialog box).

Dispersion Global
Assign the global material dispersion model to the current region. The global model assumes that a fiber is formed by doping the host material with one dopant that raises the refractive index and another dopant that lowers the index (see Material Dispersion dialog box).

Define Dispersion
Opens the Material Dispersion dialog box, where you can assign a material dispersion model based on the Sellmeier coefficients library. Alternately you can provide a custom model.

Real Profile
When the index profile is real, check this check box. Otherwise, uncheck it.

Wavelength
Enter the wavelength in microns. This wavelength is considered as the measurement wavelength. (The wavelength at which the current profile is exact. For other wavelength values used in the program (for example when scanning over a spectral range) the profile shape is adjusted accordingly based on the material dispersion model, if it is enabled.

Mesh
X: Number of points in the transverse cross-section along the X-axis
Y: Number of points in the transverse cross-section along the Y-axis
The modal fields are calculated based on the mesh setting.

Display
Real - When this radio button is selected, the real index profile will be displayed in the lefthand display window.

λ - When the Enable check box is checked, enter the wavelength, and the real index profile at this wavelength will be displayed.

Imag. - When this radio button is selected, the imaginary index profile will be displayed in the left-hand display window.

PS - When this radio button is selected, the radial photosensitivity profile will be displayed in the left-hand display window.
CHAPTER 4: USER GUIDE

Import Profile

Import the real index profile from a text file.
The format of the text file is:
radius in µm refractive index
.
.
For example, the text file for a three layers fiber profile is:
4.2 1.451
62.5 1.444
80 1.0

Export Profile

Export the real index profile to a text file
The format of the text file is same as the format described in the Import Profile

Apply

Apply the changes made in the dialog box.
Material Dispersion dialog box

The Material Dispersion dialog box displays the material index as function of wavelength. For the dispersion model, it is assumed that the fiber profile consists of regions with only the host material and doped regions. One of the dopants raises the refractive index, while the other dopant lowers it. The Dopant + and Dopant - curves show the dispersion curves for materials with a particular kind of dopant (in this case, Germanium for + and Fluorine for -) at a certain doping concentration. OptiGrating will use the index given at the centre wavelength in the Single Fiber Profile dialog box to deduce the concentration in the given layer. With this concentration found, OptiGrating will interpolate or extrapolate to find the index at other wavelengths. See the OptiGrating manual, Technical Background chapter for details.

To get the Material Dispersion dialog box:

1. Open the Fiber Profile dialog box.
2. Select Enable in the Dispersion section.
3. Press the Define button in the Dispersion section.

The Material Dispersion dialog box options are described below.

Host
Shows the name of the fiber host material. Press Define to specify the material and its dispersion model. When the User option is cleared, the Define button activates the Sellmeier Parameters dialog box. When the User option is checked, the Define button launches the User Defined Function script programming environment (see the Script Language section of the documentation).
Dopant +
Shows the name of the fiber material that has higher index due to an index-raising dopant. The Define button and the User option work the same way as for the Host option.

Dopant -
Shows the name of the fiber material that has lower index due to an index-decreasing dopant. The Define button and the User option work the same way as for the Host option.

Display From
Enter the minimum wavelength for the dispersion display.

Display To
Enter the maximum wavelength for the dispersion display.

Update
Update the dispersion display after recent changes.

Sellmeier Parameters dialog box

The Sellmeier Parameters dialog box allows you to select the material dispersion model based on the Sellmeier theory. OptiGrating uses six Sellmeier coefficients, three wavelengths and three amplitudes, to define the dispersion curve. If the Sellmeier coefficients for the material at the given doping concentration are known, you may want to put this in your Sellmeier Coefficient Library so that the dispersion used lies exactly on one of the curves shown in the Material Dispersion dialog box, rather than having to rely on an interpolation formula to calculate the effect of material dispersion. It will also be necessary to add an entry to the library if you are using a dopant different from the ones already provided.

To access this dialog box, do the following steps:
1. Open the Fiber Profile dialog box.
2. Select Enable in the Dispersion section.
4. In the Material Dispersion dialog box, press the Define button for defining the Host, Dopant +, or Dopant - material model.

Sellmeier Formula

The Sellmeier formula is displayed for reference. The formula reads:

$$n(\lambda) - 1 = \frac{A_1 \cdot \lambda^2}{\lambda_2 \cdot \lambda_1^2} + \frac{A_2 \cdot \lambda^2}{\lambda_2 \cdot \lambda_2^2} + \frac{A_3 \cdot \lambda^2}{\lambda_2 \cdot \lambda_3^2}$$
where $n$ is the wavelength-dependent refractive index, $A_1, A_2, \text{ and } A_3$ are the Sellmeier amplitudes, and $\lambda_1, \lambda_2, \text{ and } \lambda_3$ are the Sellmeier resonance wavelengths.

The Sellmeier Parameters dialog box options are described below.

**Name**

Enter the name of the material. If you select the material from the Library list (see Get below) then the name appears automatically.

$A_1, A_2, A_3$

Enter the amplitude Sellmeier coefficients.

$\lambda_1, \lambda_2, \lambda_3$

Enter the wavelength Sellmeier coefficients.

**Add**

If you entered new material along with its Sellmeier coefficients, you may add it to the library by pressing the Add button.

**Delete**

Delete the selected material from the library.

**Get**

Get the material from the Library list. The library materials are stored in a data base. Fiber_CAD provides some of the known materials along with the Sellmeier coefficients.
Function Definition dialog box

The Function Definition dialog box allows you to define the start and end values in the current region. The real index profile, imaginary index profile, and radial photosensitivity use the same set of function definitions.

With this dialog box, you can specify the following predefined functions of the region's local radial coordinate \( x \):

**Constant index profile:**

\[
n(x) = \text{const}
\]

**Linear index profile:**

\[
n(x) = n(0) + x \cdot \frac{n(w) - n(0)}{w}
\]

**Parabolic index profile:**

\[
n(x) = [n(w) - n(0)] \cdot \left(\frac{x}{w}\right)^2 + n(0)
\]

**Exponential index profile:**

\[
n(x) = [n(w) - n(0)] \cdot \frac{e}{e - 1} \cdot \exp\left(-\frac{x}{w}\right) + \frac{e \cdot n(w) - n(0)}{e - 1}
\]

where \( w \) is the region width, and \( n(0), n(w) \) are the values at \( x=0 \) (start) and \( x=w \) (end), respectively. The symbol \( e \) denotes the Euler number.

To access this dialog box, do the following steps:

1. Open the Single Fiber Profile dialog box.
2. Select the Real index list box.
3. On the list, select Linear, Parabolic, or Exponential.
4. Press the Define button under the Index option.

![Function Definition dialog box](image)

The Function Definition dialog box options are described below.
Start
Enter the start value at the beginning of the region.

End
Enter the end value at the end of the region.

See also the Index Profile of Fibers section in the Technical Background.

Gaussian User Function dialog box

The Gaussian User Function dialog box allows you to specify the Gaussian function in the current region.

Gaussian profile:

\[
n(x) = n_{max} \exp \left\{-\ln 2 \cdot \frac{2 \cdot (x - x_0)^2}{h \cdot w}\right\}
\]

where n_{max} is the maximum value, \(x_0\) is the center (peak) position, and h is the normalized Full Width at Half Maximum (FWHM).

To access this dialog box, do the following steps:

1. Open the Single Fiber Profile dialog box.
2. Select the Real index list box.
3. On the list, select Gaussian.
4. Press the Define button under the Index option.

The Gaussian user function dialog box options are described below.

**N_{max}**
Enter the maximum value described by the Gaussian function.
Norm. FWHM
Enter the normalized Full Width at Half Maximum (FWHM) of the Gaussian function.

Center Position
Enter the peak position of the Gaussian function. The position is measured from the beginning of the current region.

See also the Index Profile of Fibers in the Technical Background.

Alpha Power Law dialog box
The Alpha Power Law dialog box allows you to specify the Alpha-Power function in the current region. The Alpha-power dependence has two forms: alpha-peak and alpha dip.

Alpha –peak index profile:

\[ n(x) = n_{\text{max}} \cdot \sqrt{1 - 2\Delta \cdot \left(\frac{x}{W}\right)^\alpha} \]

where, \( n_{\text{max}} \) is the maximum value and \( \Delta \) is the normalized difference. It is defined as

\[
\Delta = \frac{n_{\text{max}}^2 - n_{\text{min}}^2}{2n_{\text{max}}^2}
\]

Alpha –dip index profile:

\[ n(x) = n_{\text{max}} \cdot \sqrt{1 - 2\Delta \cdot \left(\frac{x}{W}\right)^\alpha} \]

where, \( n_{\text{max}} \) is the maximum value and \( \Delta \) is the normalized difference.
To access this dialog box, do the following steps:

1. Open the Fiber Profile dialog box.
2. Select the Real index list box.
3. On the Function list, select Alpha-Power Peak or Alpha-Power Dip.
4. Press the Define button under the Index option.

The Alpha Power Law dialog box options are described below.

**Max Ref Index**
Enter the maximum value described by the Alpha-Power function.

**_norm Index Difference %**
Enter the normalized difference of the Alpha Power function.

**Alpha Value**
Enter the alpha power coefficient value.

See also the Index Profile of Fibers section in the Technical Background.

**User Defined Function dialog box**
The User Defined Function dialog box allows you to specify the user function. The user defined function can be almost anything that conforms to the rules of the Script Language programming.

You can find detailed information in the Working With User Defined Options section.

**Single Fiber Modes dialog box**
After you have finished the data entry in the Single Fiber dialog box, OptiGrating computes a list of guided modes. This list is displayed in the Single Fiber Modes dialog box.
Settings

In the Single Fiber modes dialog box, you can define the following options under the Settings tab:

**LP Modes**
To work with LP modes, click the LP \( m,n \) button to enable it and enter the range of the mode index \( m \) (\( m_{\text{From}} \) to \( m_{\text{To}} \)) and the maximum value of the mode index \( n \) (\( n_{\text{Max}} \)).

**Vectorial modes**
To work with vectorial modes, click one of the button (HE\( m,n \), EH\( m,n \), TE\( 0,n \), TM\( 0,n \)) to enable it and enter the range of the mode index \( m \) (\( m_{\text{From}} \) to \( m_{\text{To}} \)) and the maximum value of the mode index \( n \) (\( n_{\text{Max}} \)).
CHAPTER 4: USER GUIDE

Recalculate Modes
Press this button to start the mode calculation

Select All
Select all the modes from the mode list

Deselect All
Deselect all the modes from the mode list

Set
Set the current selected mode as input mode

Input amplitude
The amplitude of the selected input mode

Phase
The phase of the selected input mode

View
View and export the modal fields. See 3D Preview of the field dialog box.

Export Index
Export the effective refractive index to a text file.
Advanced Settings

Under the Advanced Settings tab, you get the following additional choices:

- Choosing Real or Complex will determine which variables you can change.

In the Real option, real solutions will be sought in the interval specified in the Real From and To fields. The solver will step through this interval in steps of Step Size. In the Complex option, solutions are sought in a rectangular region of the complex plane as defined by the From and To fields in both real and imaginary. The Complex option uses an advanced technique for finding the roots as described in the Technical Background chapter of the OptiGrating manual.
To compute guided modes

1. File > New.
3. In the Project window, click the Fiber/Waveguide Parameters button.
4. In the Single Fiber Profile dialog box, enter the desired values and press the OK button.
5. In the Project window, click the Mode Parameters button.
6. In the Single Fiber Modes dialog box, select modes from the list of guided modes.
7. In the Input Amplitude and Phase boxes, enter the desired values.
8. Choose the Advanced Settings tab.
9. In the Advanced Settings dialog, choose either Real or Complex in the Solver box to enter desired values and press OK.

3D Preview of the field dialog box

To Access the 3D Preview of the field dialog box

Follow steps 1 to 5 from the “To compute guided modes” procedure.

1. Press the view button in the Single Fiber Modes dialog box.

   Note: You can also access this dialog box from the Fiber Coupler Modes dialog box.

The Properties of the dialog box options are described below.

**Component**
Enable one of the component buttons: Ex, Ey, Ez, Hx, Hy, Hz. The enabled field component will be displayed and exported.

**Mesh**
X - Number of points in the transverse cross-section along X-axis
Y - Number of points in the transverse cross-section along Y-axis

**Apply**
Apply the changes made in the dialog box.

**Export**
Export the modal field. The file format is the field *.f3d of BPM_CAD.
The exported 3D Complex Format:

BCF3DCX - File Header
NX NY - Number Of x And y Data Points
WX WY - Mesh Width In x And y
Z1 - Complex Number z Data Point With Coordinates (xmin, ymin)
Z2 - Complex Number z Data Point With Coordinates (xmin+dx, ymin)
Z3 – Complex Number z Data Point With Coordinates (xmin+2dx, ymin)

ZNX – Complex Number z Data Point With Coordinates (xmax, ymin)
ZNX+1 – Complex Number z Data Point With Coordinates (xmin, ymin+dy)

ZN – last Complex Number z Data Point With Coordinates (xmax, ymax), N=NxNy
Where dx = (xmax-xmin)/(nx-1) and dy = (ymax – ymin)/(ny-1).

Save Graph
Save the graph as a Windows Enhanced Metafile (.emf).

Using Calculation Options

The last step before getting numerical results is to select one of the calculation options: Propagation, Spectrum, Pulse Response, Parameter Scan.

Propagation

Reflection and transmission along the device.

You can select the number of propagation steps and the signal wavelength. Notice that the signal wavelength in the Wavelength box can be different from the central wavelength used in the Single Fiber dialog box. This option allows you to study the propagation at wavelengths close to the central wavelength. By default, the wavelength is set equal to the central wavelength.
To use the Propagation calculation option

1. Follow steps 1 to 5 from the “To compute guided modes” procedure.
2. In the Single Fiber Modes dialog box, select a mode from the list of Fiber Modes.
3. In the Input Amplitude and Phase boxes, enter the desired values and click the OK button.
4. In the Project window, choose Propagation from the Calculation list box.
5. In the Propagation Step box and in the Wavelength box, enter the desired values and click the Calculate button.

Spectrum

Reflection and transmission at the input and output ports of the device within a range of wavelengths.

To use the Spectrum calculation option

1. Follow step 1 to 5 from the “To compute guided modes” procedure.
2. In the Single Fiber Modes dialog box, select a mode from the list of Fiber Modes.
3. In the Input Amplitude and Phase boxes, enter the desired values and click the OK button.
4. In the Project window, choose Spectrum from the Calculation list box.
5. In the From, To, and Step boxes, type the desired values and click the Calculate button.

Pulse Response

Input pulse intensity spectrum, grating spectrum, output pulse intensity.

To use the Pulse Response calculation option

1. Follow step 1 to 5 from the “To compute guided modes” procedure.
2. In the Single Fiber Modes dialog box, select a mode from the list of Fiber Modes.
3. In the Input Amplitude and Phase boxes, enter the desired values and click the OK button.
4. In the Project window, choose Pulse Response from the Calculation list box.
5. In the Steps, Time Span, and Wavelength boxes, type the desired values and click the Calculate button.
To work in the Pulse Response dialog box

1. In the Project window, from the calculation list box, choose Pulse Response.
2. In the Input View dialog box, click the Define button to open the Pulse Response dialog box.

3. In the Input Pulse section, choose either Gaussian or User Defined from the list box. If Gaussian is selected, you will be able to enter an Intensity FWHM value in the Intensity box, where FWHM is the Full Width at Half Maximum in picoseconds.

4. If you want to define the fiber or waveguide Length and Chromatic Dispersion, enable the Link check box.

5. The Length is measured in kilometers; the Chromatic Dispersion is measured in picoseconds per nanometer per kilometer.

Note: If you select User Defined from the list box, the Define button is enabled. When you click it, you will be able to set your preferences in the User Defined Function dialog box. If you enable the Link check box, you will see two pulses displayed in the Input tab of the Project window: the input pulse at the beginning of the fiber link and the input pulse after propagation through the fiber link, but at the beginning of the grating.

Parameter Scan

The bandwidth, sidelobe, peak value, peak position and dispersion at central wavelength within the range of the selected grating parameter. OptiGrating allows you to define the number of calculation steps.
To use the Parameter Scan calculation option
1. Follow steps 1 to 5 from the “To compute guided modes” procedure.
2. In the Input Amplitude and Phase boxes, enter the desired values and click the OK button.
3. From Calculation menu, select Scan.
4. In the Scan dialog box, type the desired values and click the Calculate button.

Setting Options in the Fiber Bragg Grating Sensor Dialog Box

The Fiber Bragg Grating Sensor dialog box allows you to set Strain and Temperature options and to define Strain-optic and Thermo-optic parameters. It is only available for two layer stepindex fibers.

To define options in the Fiber Bragg Grating Sensor dialog box
1. File > New.
2. In the New dialog box, click Single Fiber.
3. From the Parameters drop down menu, click Grating Parameters.
4. In the Grating Manager dialog box, double-click the desired grating.
5. In the Grating Definition dialog box, enable the Sensors check box.
6. Press the Define button to open the Fiber Bragg Gratings Sensor dialog box.
In the Fiber Bragg Grating Sensor dialog box, define the Strain-optic and the Thermo-optic parameters and the Strain and Temperature options.

Click the OK button.

**Note:** For more details about the parameters available in Fiber Bragg Grating Sensor dialog box, see the Technical Background section.

**Setting options in the Long Period Grating Sensor dialog box**

In the Long Grating Sensor dialog box, you can define the Strain-optic parameters, Thermo-optic parameters, Cladding, Micro-strain distribution along the grating, and the temperature distribution along the grating. It is only available for three layer step-index fibers.

**To define options in the Long Period Grating Sensor box**

1. File > New.
2. In the New dialog box, click Single Fiber.
3. From the Parameters drop down menu, click the Grating Parameters button.
4. In the Grating Manager dialog box, double-click the desired grating to open the Grating Definition dialog box.
5. In the Grating Definition dialog box, enable the Sensors check box and click the Define button to open the Long Period Grating Sensor dialog box.
In the Micro-strain section, choose one of the following options from the list box: Uniform, Linear, Gaussian, or User Defined.

- Uniform – constant value along the distance
- Linear – linearly-varying with the distance, provides start and end values
- Gaussian – Gaussian-varying along the distance. Gaussian in grating strain and temperature distributions (See the Technical Background chapter).
- User Defined – when selected enables the Used Function button that opens the User Defined Function dialog box

From the Temperature list, choose one of the following options to define the temperature distribution along the grating: Uniform, Linear, Gaussian, or User Defined.

**Note:** For information about the Strain-optic Parameters, Cladding, and Thermo-optic Parameters, see the Technical Background chapter.
The Fiber Coupler

File: New > Fiber Coupler

The Fiber Coupler Module

You use the Fiber Coupler module to model two fibers embedded in one infinite cladding. The grating can be placed anywhere in the coupler. OptiGrating allows you to adjust both the fiber coupler dimensions and refractive index profile and photosensitivity profile.

You can optimize the coupling between the modes of the two fibers. There are two mode options available: LP modes or full, vector modes (HE, EH, TE, or TM) of the fibers. The vector modes option is only available for step-index fiber. The Fiber Coupler module finds applications in co-directional and contra-directional grating assisted coupler, direct and exchange fiber Bragg reflectors, and filters.

To select the Fiber Coupler module

1. File > New.
2. In the New dialog box, click Fiber Coupler.

The Fiber Coupler dialog box

In this dialog box, you enter the main data concerning the fiber coupler dimensions, index profile, and photosensitive profile.
To open the Fiber Coupler dialog box

1. File > New.
2. In the New dialog box, click Fiber Coupler.
3. In the Project window, click the Fiber/Waveguide Parameters button.

The Fiber Coupler Profile dialog box options are described below.

**Fiber 1**
Select Fiber 1 button to define the profile of fiber 1. The options for fiber 1 are same as Single Fiber profile (see Single Fiber Profile dialog box).

**Fiber 2**
Select Fiber 2 button to define the profile of fiber 2. The options for fiber 2 are same as Single Fiber profile (see Single Fiber Profile dialog box).

**Distance**
Distance is the width of the shortest common cladding of the coupler.
Note: To make sure the fiber coupler has common cladding, The outmost regions of Fiber 1 and Fiber 2 should be defined by constant real index profile with Steps equal to 1 with same index value.

**Fiber Coupler Modes dialog box**

After you have finished the data entry for the fibers in the Fiber Coupler Profile dialog box, OptiGrating prepares lists of guided modes, which include separate calculations for Fiber 1 and Fiber 2. The lists of guided modes are displayed in the Fiber Coupler Modes dialog box. You can select one Fiber 1 mode and one Fiber 2 mode.

The options in the Fiber Coupler modes dialog box are similar to the one in the Single Fiber Modes dialog box.
To compute guided modes in the Fiber Coupler Modes dialog box

1. In the Fiber Coupler Modes dialog box, select one mode from the Fiber 1 Modes list box and one mode from the Fiber 2 Modes list box.
2. In the Fiber 1 Amplitude and in the Fiber 2 Amplitude boxes, type the desired values.
3. In the Phase boxes, enter the desired values and click the OK button.
Clicking on either the Fiber 1 or Fiber 2 tabs will bring up the following choices:

- Similar to the Advanced Settings option in Single Fiber Modes, choosing either the Real or Complex button in the Solver box will determine which variables you may change.

  In the Real option, real solutions will be sought in the interval specified in the Real From and To fields. The solver will step through this interval in steps of Step Size.

  In the Complex option, solutions are sought in a rectangular region of the complex plane as defined by the From and To fields in both real and imaginary. The Complex option uses an advanced technique for finding the roots as described in the Technical Background chapter of the OptiGrating manual.
Single Waveguide

File: New > Single Waveguide

The Single Waveguide Module

You use the Single Waveguide to model a multilayer slab waveguide with grating. The grating can be placed on the interface of layers as surface relief grating, or in layers as index-modulated grating.

cladding

---

waveguide  grating

---

substrate

You can simulate the coupling between forward and backward propagating modes. There are two mode options available: TE or TM modes of the waveguide. The Single Waveguide module finds applications in thin-film optical filters, distributed feedback lasers (DFB), distributed Bragg reflector lasers (DBR), and waveguide Bragg reflectors.

To select the Single Waveguide module

1  File > New.
2  In the New dialog box, click Single Waveguide.

The Single Waveguide Profile dialog box

In this dialog box, you enter the main data concerning the single waveguide dimensions, index profile, and photosensitive profile.

To open the Single Waveguide dialog box

1  In the Gratings box, click the Fiber/Waveguide Parameters button.
2  In the Single Waveguide dialog box, you can define the following options:
Photosensitivity

**Type:** Select one of the following options for the radial photosensitivity profile within the current region:

Constant - Constant value of radial photosensitivity
Linear
Parabolic
Gaussian
Exponential
Alpha-peak
Alpha-dip
User Function - Functional dependence of the sensitivity, where the function is defined or programmed using the powerful Script Language environment.
**Value**: Numerical data entry box - Present when the constant radial photosensitivity option was selected. Enter the radial photosensitivity value for the selected region.

**Define**: Present when the Function or User Function option was selected. Press the Define button to specify the function. For the built-in functions, a dialog box related to one of the predefined functions appears. For the User Function option, pressing the Define button launches the User Defined Function script-programming environment.

**Note**: The surface-relief grating will be located at the top of the region when the photosensitivity of this region is not equal to zero. The gratings can only be located at one waveguide interface. If more than one region is photosensitive, the grating will be located at the first region (in the region list). The definitions of other photosensitivity will be ignored.

**Mesh**: Number of points in the transverse cross-section along Y-axis

The definitions of the other Options in this dialog box are same as in the Single fiber profile dialog box.

### Single Waveguide Modes dialog box

After you have finished the data entry in the Single Waveguide dialog box, OptiGrating allows you to compute Waveguide modes. The waveguide modes are listed in the Single Waveguides Modes dialog box. You can select modes for calculations.

In the single Fiber modes dialog box, you can define the following options:

**Vectorial modes**

- **TE**: Check this option to calculate the Transverse Electric (TE) modes of waveguide
- **TM**: Check this option to calculate the Transverse Magnetic (TM) modes of waveguide

**View**

View and export the modal fields. See 2D Preview of the field dialog box.

**Recalculate Modes**

Press this button to start calculate modes

**Select All**

Select all the modes from the mode list

**Deselect All**

Deselect all the modes from the mode list

**Set**

Set the current selected mode as input mode

**Input amplitude**

The amplitude of the selected input mode
Phase
The phase of the selected input mode

Export Index
Export the effective refractive index to a text file.
To compute guided modes in the Single Waveguide Modes dialog box

1. File > New.
2. In the New dialog box, click Single Waveguide.
3. In the Gratings box, click the Fiber/Waveguide Parameters button.
4. In the Single Waveguide dialog box, enter the desired values and press the OK button.
5. In the Single Waveguide Modes dialog box, select modes from the list.
6. In the Input Amplitude and Phase boxes, enter the desired values.
7. Choose the Advanced Settings Tab.
8. In the Advanced Settings dialog box, choose either Real or Complex in the Solver box to enter the desired values and press OK.
By selecting the Advanced Tab in the Single Waveguide Modes window, you will see the following choices:

- Similar to the Advanced Settings option in Single Fiber Modes, choosing either the Real or Complex button in the Solver box will determine which variables you may change.

In the Real option, real solutions will be sought in the interval specified in the Real From and To fields. The solver will step through this interval in steps of Step Size.

In the Complex option, solutions are sought in a rectangular region of the complex plane as defined by the From and To fields in both real and imaginary. The Complex option uses an advanced technique for finding the roots as described in the Technical Background chapter of the OptiGrating manual.
2D Preview of the field dialog box

To Access the 2D Preview of the field dialog box:

1. Follow steps 1 to 5 from the “To compute guided modes” procedure in Single Waveguide Modes dialog box section.
2. Press the view button in the Single Waveguide Modes dialog box.

Note: You can also access this dialog box from Waveguide Coupler Modes dialog box.

The Properties of the dialog box options are described below.

Component
Enable one of the component buttons: Ex, Ey, Ez, Hx, Hy, Hz. The enabled field component will be displayed and exported.

Mesh
Number of points in the transverse cross-section along Y-axis

Apply
Apply the changes made in the dialog box.

Export
Export the modal field. The file format is the field *.f2d of BPM_CAD. The exported 2D Complex Format:
2D complex format:
BCF2DCX - File Header
N - Number Of Data Points
W - Mesh Width (µm)

Z1 - First Complex Data Point
Z2 - Second Complex Data Point
.
.
.
ZN - Last Complex Data Point

Using Calculation Options
The calculation options are similar to the ones described in the Single Fiber calculation section.

Waveguide Coupler
File: New > Waveguide Coupler

The Waveguide Coupler Module
You use the Waveguide Coupler Module to model a two slab waveguide with a grating. The grating can be placed on the interface of layers as surface relief grating, or in layers as indexmodulated grating.

You can simulate the coupling between modes of the two waveguides. There are two mode options available: TE or TM modes of the waveguide. The Waveguide Coupler finds applications in waveguide co-directional and contra-directional couplers, direct and exchange waveguide Bragg reflectors, and in filters.
The Waveguide Coupler Profile dialog box

In the Waveguide Coupler dialog box, you enter the main data concerning the waveguide coupler dimensions, index profile, and photosensitive profile.

To open the Waveguide Coupler dialog box

1. File > New.
2. In the New dialog box, click Waveguide Coupler.
3. In the Project window, click the Fiber/Waveguide Parameters button.
4. In the Waveguide Coupler dialog box, you can define the following options:

**Waveguide 1**
Select Waveguide 1 button to define the profile of waveguide 1. The options for waveguide 1 are same as Single Waveguide profile (see Single Waveguide Profile dialog box).

**Waveguide 2**
Select Waveguide 2 button to define the profile of waveguide 2. The options for waveguide 2 are same as Single Waveguide profile (see Single Waveguide Profile dialog box).

**Distance**
Distance is the width of the common cladding of the coupler.

*Note:* To make sure the waveguide coupler has common cladding, the last region of Waveguide 1 (Point A) and the first region of Waveguide 2 (Point B) should be defined by constant real index profile with Steps equal to 1 with same index value. The width of the last region and the first region of Waveguide 2 are not important, as the sum of these widths is replaced by Distance.
After you have finished the data entry in the Waveguide Coupler profile dialog box, OptiGrating computes two lists of guided modes, which are displayed in the Waveguide Coupler Modes dialog box. You can select one Waveguide 1 mode and one Waveguide 2 mode.

The options in the Waveguide Coupler Modes dialog box are similar to the ones in the Sin-Waveguide Modes dialog box.
To compute waveguide coupler modes

1. File > New.
2. New > Waveguide Coupler.
3. In the Project window, click the Fiber/Waveguide parameters button.
4. In the Waveguide Coupler Profile dialog box, enter the desired values and click the OK button.
5. In the Waveguide Coupler Modes Settings tab, select one mode from the Waveguide 1 Modes list and one mode from the Waveguide 2 Modes list.
6. In the Waveguide 1 and Waveguide 2 Amplitude boxes, enter the desired values.
7. In the Phase boxes for Waveguide 1 and Waveguide 2, enter the desired values.
8. Choose either the Waveguide 1 or Waveguide 2 tab, to get the following options:
• Similar to the Advanced Settings option in Single Fiber Modes, choosing either the Real or Complex button in the Solver box will determine which variables you may change.

In the Real option, real solutions will be sought in the interval specified in the Real From and To fields. The solver will step through this interval in steps of Step Size.

In the Complex option, solutions are sought in a rectangular region of the complex plane as defined by the From and To fields in both real and imaginary. The Complex option uses an advanced technique for finding the roots as described in the Technical Background chapter of the OptiGrating manual.

9 Click OK.

Using Calculation Options
The calculation options are similar to the ones described in Single Fiber calculation section.

Other Waveguide

File: New > Other Waveguide

The Other Waveguide Module
You use the Other Waveguide Module to model general waveguides with a grating. In this module, the user needs to define the mode properties instead of the waveguide profile in the other modules. The Other Waveguide module finds application in WDM add/drop filters, Bragg gratings, Long Period Gratings.

To choose the Other Waveguide module
1 File > New.
2 New > Other Waveguide.

The Mode Properties Dialog Box
In this dialog box, you enter the main data concerning the mode properties of the waveguide.

To open the mode properties dialog box
1 In the Project window, click the Mode Parameters button.
2 In the Mode Properties dialog box, you can define the following options:
### Input Mode

**Effective Index Real** - The real part of the modal index of the input mode

**Effective Index Imaginary** - The imaginary part of the modal index of the input mode

**Overlap Integral** - The overlap integral value of the input mode in the grating region. The Overlap Integral in the Input Mode panel is the overlap integral of the input field with itself. This quantity is also called Confinement Factor.

**Real** - Check this box when the effective index is pure real. Otherwise uncheck this box.

**Add**

If only the Input Mode panel contains data, then the simulation will be for a single mode waveguide that has a single transmission and reflection spectrum. If the waveguide has more than one mode, and the grating causes coupling among the forward and backward directions in those other modes, the software will need more data to define the parameters of the additional modes. This button allows you to add the information about a new mode by adding an item at the end of the mode list.

**Insert**

This button allows you to insert a new line for mode information before the current selected line.
Edit
This button allows you to edit the selected line.

Delete
This button is used to delete a selected line.

Delete All
This button deletes all the items in the mode list.

Mode Name
Name of the mode in the mode list.

Eff. Ind. Real
Real part of the modal index of the mode in the list

Eff. Ind. Imaginary
Imaginary part of the modal index of the mode in the list

Overlap Integral
In the mode list, the Overlap integral (OLI) is the overlap integral value between the mode in the mode list and the input mode, where the integral is evaluated over the grating region.

\[
OLI = \left| \int \int \frac{E_1(x, y) E_2(x, y) dx dy}{\Omega} \right|
\]

\(\Omega\) is the region in the transverse \((x,y)\) plane occupied by the grating. \(E_1\) and \(E_2\) are the mode field patterns of the input mode and the higher order mode and both are normalized to unity i.e.

\[
1 = \int \int |E_1(x, y)|^2 dx dy
\]

\(-\infty < x < \infty, -\infty < y < \infty\)

Note that the Overlap Integral in the Input Mode panel is the overlap integral of the input field with itself. This quantity is also called Confinement Factor.

**Using Calculation Options**

The calculation options are similar to the ones described in Single Fiber calculation section.
CHAPTER 4: USER GUIDE

Open

File: Open

File: New > Module option > File: Open

The Open command

OptiGrating allows you to open the following files:

.IFO
OptiGrating data files (those from IFO_Gratings 1.0, IFO_Gratings 2.0, IFO_Gratings 3.0, and IFO_Gratings 4.0) have an .ifo extension.

.IWS
All workspace files (see Save Workspace) are saved with this extension. In each Workspace file, there is also at least one .ifo file. A workspace file has only a link to an .ifo data file. It does not contain any .ifo data; it contains all the information about the file you open and the number and the location of the windows. The .ifo data files are the files containing all the data and without them .iws files are useless.

Note: If you distribute an .iws file, you also need to distribute all .ifo files which the .iws file uses. If you save an .iws file in the folder the .ifo files use, the .ifo file names inside the .iws file will be saved without a path.

.TPL
The .tpl files are template files, much like workspace file, but they don’t contain coded .ifo data files; instead, template files ask you to open any .ifo data file you like.
To open a file
1. File > Open.
2. In the Open dialog box, choose a type of file from the Files Of Type list box.
3. In the File Name box, write the name of the file you want to open or use the Browser button to find the file you want to open.
4. Click the Open button.

Save Workspace

File: New > Module option > File: Save Workspace

The Save Workspace command
OptiGrating allows you to clone views, i.e. to use multiple graph windows. You can set the size and the position of each window on the screen according to your preferences. The Save Workspace command allows you to save not only the settings but also all the information in each window for future use. Therefore, each workspace file contains at least one .ifo file.

In the Save Workspace dialog box, you have to name the file and save it with an .iws extension. Then, you may be asked to save changes in your .ifo file. If you haven't assigned a name to your .ifo file yet, you will be asked to do so.

To save a workspace
1. File > New.
2. In the New dialog box, choose one of the Module options.
3. From the File menu, click Save Workspace.
4. In the Save Workspace dialog box, type the name of the file in the File Name box.
5. From the Save As Type list box, choose IFO Workspace (.iws).
6. Click the Save button.

The Edit Menu

The Edit menu allows you to use one of the following command:

Undo
Reverses one or more of your last commands. You can use Undo only when you are in Memo mode, i.e. only when you are copying text. (View: New > Memo).
The View Menu

The View menu can display and hide elements from the user interface (for example, the Toolbars and the Status Bar).

- **Status Bar**
  - When enabled, displays the Status Bar; when disabled, hides the Status Bar. The Status Bar is placed at the bottom part of the user interface. It gives you different prompts and tells you where to find help.

- **Hide Form Pane**
  - When enabled, hides the Input View window. When disabled, displays the Input View window. To display or hide the Input View window, from the View menu, click the Hide Form Pane button.

- **Toolbars**
  - Allows you to display and hide the following toolbars: Graphic, Parameters, Window, Main. When an option is enabled, the appropriate toolbar is displayed; when an option is disabled, the toolbar is hidden.

- **New**
  - Allows you to display and hide eight views which can all be displayed in the Multiple View window.

Using the commands in the New submenu

The OptiGrating 4.2 Multiple View window consists of several different views.
Five of the View windows - Power, Phase, Delay, Dispersion, Scan and Profile - offer graphic views and give you different graphic results. The Input View allows you to enter calculation options while the Memo View enables you to write some comments about the graph or project you are working with.

If you “clone” all views listed in the New submenu shown above (View > New), they will become separate windows instead of being docked in a multiple window. You will then be able to size and position them in a workspace.

You can also clone the Multiple View window, and you can have more than one of each window. To clone all views, i.e. to undock them from the Multiple View window, click the All Views button.

**Note:** You can also clone an active view, a view you are currently using, by clicking the Open Active View button on the toolbar. When you are cloning a view, the cloned window is not separated from the document. Since all cloned windows share the same document, if you change your calculation options, all cloned windows will be redrawn according to your changes.

**To use the Input View window as a separate window**

1. File > New.
2. In the New dialog box, choose one of the five modules and enter the desired values in the dialog box.
3. From the View menu, click New, Input View.
4. In the Input View window, enter the desired calculation values.

You will notice that the window's options change according to the type of calculation performed: Propagation, Spectrum, and Pulse Response.

**Note:** You can also open the Input View window in a separate window by clicking anywhere in this window and pressing the Open Active View button on the Toolbar.
The Calculation Menu

The Calculation menu allows you to do your calculations quickly and efficiently.

Run
To perform your Calculation, Spectrum, and Pulse Response calculations, just click either Run from the Calculation menu or the Run button on the Toolbar.

In the dialog box that opens, you can see when the calculation is completed.

Scan
To perform your parameter scan calculation.

Inverse Scattering Solver
To solve the inverse scattering problem of Bragg gratings. The method is based on a layerpeeling algorithm. See the Technical Background chapter of the OptiGrating manual for details.
The Scan dialog box

Select Grating/Phase Shift
Select either Grating or Phase Shift from the list

Select Scan Parameter
Select a scan parameter from the grating list in this section

Scan the Parameter
From – Initial value of the scan parameter
To – final value of the scan parameter
Steps – Number of the calculation steps in the Scan calculation
The Inverse Scattering Solver

For detailed information on how to use the Inverse Scattering Solver to solve the inverse scattering problem, please refer to Lessons 5 -8 in the Tutorial section of the OptiGrating manual.

**From**
The starting wavelength.

**To**
The ending wavelength.

**Steps**
The Steps field indicates the number of divisions used in the specified wavelength range.
Ref/Tran Define
Brings up a dialog box for defining the target reflectivity spectrum as seen below:

- Click on Display to plot the curve shown. The desired impulse response will be calculated from the Fourier transform of the reflection coefficient.

Dispersion profile Define
Located beside the Phase, Delay, and Disp radio buttons. Defines the target spectrum for the quantity indicated by the radio buttons.

Length
This is the length of the grating.

From File
Enable this checkbox and define a path to a file which contains a complex reflection spectrum. The algorithm will try to find a grating that has this spectrum.

Segments
The grating length is divided into this number of segments. Each segment has a constant coupling coefficient.

Over Sample
Over Sample is used in the reconstruction of the truncated impulse response. Accuracy is sometimes improved by using finer steps in the spectrum.
Causality
Clicking on this button will display the impulse response calculated from the spectrum the user has defined.

Clicking on Causality will show the following screen:

- Because of causality, any real impulse response must be zero for negative arguments.

**Note:** You can experiment with various delays by entering other numbers in the Linear Phase Shift field, and clicking the Impulse Response to see the result.

Start
Clicking on start begins the reconstruction. A progress bar indicates the progress of the layer peeling algorithm. When this process finishes, the reconstructed grating profile is used to generate the spectrum of the new grating. A second progress bar displays the progress of the calculation of the spectrum.

The Parameters Menu

The Parameters menu gives you access to all grating parameters: Fiber/Waveguide, Mode, Grating, Dispersion.

**Fiber/Waveguide**
Depending on which module you calculate, the Fiber/Waveguide command gives you the basic parameters about fiber or waveguide profile, including refractive index profile, Photosensitivity profile.
Mode
Shows a list of supported modes for entered Fiber/Waveguide Parameters.

Grating
Opens the Grating Manager. In the Grating Manager dialog box, you add gratings, phase shifts, and change data.

Dispersion
The material and waveguide dispersion are included for the selected calculation.

Grating Manager

File: New > Module option > Parameters: Grating

The Grating Manager
The Grating Manager allows you to define the grating structure as a collection of gratings.

To open the Grating Manager
1 Parameters > Grating.

Note: You can also open the Grating Manager dialog box by clicking the Grating button in the Grating Manager dialog box.
CHAPTER 4: USER GUIDE

Working With the Grating Manager

The Grating Manager allows you to perform all of your tasks quickly and effectively by using the following buttons:

Add Grating or Add Phase Shift

Those buttons allow you to add an item (a grating or a phase shift) that uses the default values at the end of the list.

When you click the Grating button in the Grating manager dialog box, and then click the Edit Item button, the Grating Definition dialog box opens.

When you click the Add Phase Shift button, the Phase Shift dialog box opens, and you can define the phase shift between the gratings. To do so, enable the Phase button, click the Edit Item button to open the Phase Shift box, type a value in the Phase box, and click the OK button.

Copy Selected Items or Delete Selected Items

Those buttons allow you to copy and delete multiple items from the list.

The copied objects are added at the end of the list and stay selected so that if you want to copy the same selection of items again, you just have to press the Copy button. Thus, you can easily create a fiber/waveguide that consists of hundreds of grating objects. When copying a grating, you have to specify its parameters in the Grating Definition dialog box.

Use the Delete Selected Items button to delete multiple grating objects, but remember that there should be always one object left in the list (so that the structure can exist). Therefore, if you have selected all objects and try to delete all of them, the first one will always stay.

Undo Copy/Delete

Reverses the last Copy or Delete operation performed.
Redo Copy/Delete

Cancels the last Undo Copy/Delete operation performed.

Move One Item Up or Move One Item Down

Those buttons allow you to move an item up and down the list. You can move only one object at a time.

Select All or Deselect All

Those two buttons allow you to select and deselect all objects listed.

Edit Item

Opens the Grating Definition dialog box in which you can set many grating characteristics.

Setting Options in the Grating Definition Dialog Box

The Grating Definition dialog box opens when you add a new grating to the list in the Grating Manager or when you edit an existing grating.

To set options in the Grating Definition dialog box

1. From the Parameters menu, click Gratings or click the Edit Item button in the Grating Manager dialog box.

2. In the Grating Manager dialog box, select a grating object from the list and click the Edit Item button to open the Grating Definition dialog box.
3 In the Order box, type an integer value for the order of the grating.

4 In the Tilt Angle box, type a value for the tilt angle.

5 From the period list box, choose a grating period that matches the co-directional or contradirectional coupling condition.

Define the Grating by the following parameters:

**Surface Grating.** Check this checkbox when you want to define a surface relief waveguide grating.

**Order.** Define the order of the grating.

**Tilt Angle.** Define the tilt angle of the grating (in degrees).

**Period.** Define the grating period at the center of the grating.

*Note:* For a given set of modes the program suggests period values that match the coupling conditions. If you enable the Auto check box, you won’t be able to enter a period value other than the suggested one. To enter your own value of the period, disable the Auto check box.

**Apply.** Press this button to re-calculate the default grating periods based on the entered Order and Tilt angle values.

**Grating Shape.** The Grating Shape list box allows you to choose one of the following options for the modulation of the grating shape: Sine, Rectangle, from file, or User Defined.

**Average Index.** The Average Index list box allows you to choose one of the following options: Uniform, Linear, From File, or User Defined.

**Period Chirp.** The Period Chirp list box, offers you the following options: Linear, Quadratic, Square Root, Cubic Root, From File, and User Defined.
**Note:** Period chirp is defined as a variation of the grating period along the distance. The total chirp is defined as the difference between the first and the last grating period.

**Apodization.** The Apodization list box allows you to use one of the following options for varying modulation of the grating: Uniform, Gaussian, Hyperbolic Tangent, From File, and User Defined.

**Length.** In the Length box, you define the grating’s length. Enable the Autocorrect check box to ensure that the grating has an integer number of full periods.

**Ind. Mod.** In the Index Modulation box, you define the amplitude of the index modulation of the grating.

**Height.** In the Height box, you define the height of the surface relief grating. The height modulation, measured in microns, is used for surface relief gratings in the Single Waveguide and Waveguide Coupler modules.

**Shift.** In the Shift box, you enter the value that shifts the origin of the grating shape function forward. The shift is measured in grating periods. For example, a value of 0.25 shifts the origin of the shape for a quarter of a period, i.e. the grating's shape becomes the cosine function.

**Number Of Segments.** In the Number Of Segments box, you enter the number of subdivisions for the Transfer Matrix Method. For example, the non-uniform grating can be divided in 10 uniform segments.

**Sensor.** Check this check box to define sensor parameters. You enable the Sensors check box only when you are working with the Single fiber module.

**Note:** When you choose the From File option, the program invokes a spreadsheet utility, and you can define the data table or read an external data file.

### From File

The From File option exists in four of the list boxes in the Grating Definition dialog box (in the Grating shape, the Average Index, the Period Chirp, and the Apodization list boxes).

When you read From File data concerning average index, chirp or apodization (not the grating shape), the program opens a table in which you can enter your data manually or load an external file:

**To use the From File option to enter data manually**

1. Parameters > Grating.
2. In the Grating Manager, select a grating object and click the Edit Item button.
3. In the Gratings Definition box, from the Average Index, the Period Chirp, or the Apodization list boxes, choose From File.
4. In the Table dialog box, enter the value of chirp or apodization for each grating segment.
CHAPTER 4: USER GUIDE

*Note:* You can add and remove rows by clicking the Add Row and Remove Last Row buttons. You can also save your table or open an external file.

**To use the From File option to load an external file**

1. Parameters > Grating.
2. In the Grating Manager, select a grating object and click the Edit Item button.
3. In the Gratings Definition box, from the Average Index, the Period Chirp, or the Apodization list boxes, choose From File.
4. In the Table dialog box, click the open button.
5. In the Open dialog box, define the file name and the type of file you want to open and click the Open button.

**To use the From File option to load the grating shape from an external file**

1. Parameters > Grating.
2. In the Grating Manager, select a grating object and click the Edit Item button.
3. In the Gratings Definition box, from the Grating Shape list boxes, choose From File.
4. Press the Define button at the right hand of Grating Shape list.
5. In the Open dialog box, define the file name and the type of file you want to open and click the Open button.

**The external data file Format**

The external data file contains one or two columns of numbers in text format, separated by a comma or a space.

**Two Columns** - If the file has two columns, the first column is the position along the grating length (for Average Index, period chirp, and Apodization) or the position along a single period (For Grating Shape). The second column is the defined Grating Shape, Average Index, Period Chirp, or Apodization value.

**One Column** – In this case, the column is the defined Grating Shape, Average Index, Period Chirp, or Apodization value. It is assumed that the defined data are uniformly distributed.
User Defined

The User Defined option is available in four of the list boxes - Grating Shape, Average Index, Period Chirp, Apodization - in the Grating Definition dialog box. You can define functions that determine the shape, chirp, and apodization of the grating. A special environment provides you with the necessary tools to edit the function.

To choose the User Defined option

1. Parameters > Grating.
2. In the Grating Manager, select a grating object and click the Edit Item button.
3. In the Gratings Definition dialog box, from the Grating Shape, the Average Index, the Period Chirp, or the Apodization list boxes, choose User Defined.
4. Click the Define button.
5. In the Used Defined Function dialog box, choose the desired options and click the OK button.

Working With User Defined options

Since User Defined options are very important for your work, you may want to have a look at the following example:

Let's say that you want to use the User Defined option to define the Apodization function. Follow step 1 and 2, described in the above procedure, and from the Apodization list box, choose User Defined to open the User Defined Functions dialog box. The User Defined Function dialog box is split into two: the editing area and the display area.

The Editing Area

You define the function in the editing area. For your convenience, the editing area is a simplified programming editor. To define a function, you type the function formula. In the formula, you can use numbers, constants, variables, and other functions. Standard mathematical operators are supported. The program keeps a list of mathematical constants, design (global) variables, and mathematical functions.

In general, the User Defined function has one independent variable, called x, which has the following ranges:

From 0 to Grating Period – in the user definition of Grating Shape.
From 0 to Length – in the user definition of Grating Chirp and Apodization.

The x-variable is called the global variable. Other global variables related to the grating are the Grating Length and Period. You can use them in your function.
The Display Area

The graph of the function is shown in the display area.

![Graph of function](image)

Working in the Editing Area

Since this example shows you how to use the User Defined option to define the Apodization function, let's assume that you need the Apodization function \( \tanh(s \cdot (x/\text{Length})) \cdot \tanh(s \cdot (1-x/\text{Length})) \), where \( s = 4 \). All you have to do is type the following two lines in the User Function Definition editing area:

\[
\begin{align*}
    s & = 4 \\
    \tanh(s \cdot (x/\text{Length})) \cdot \tanh(s \cdot (1-x/\text{Length})) & 
\end{align*}
\]

Exploring the User Defined Function program editor

As mentioned above, the editing area is a simplified programming editor. You can not only write your own functions but also test and debug the program. The format of the language is very close to BASIC. For more information, see the Appendix A.

Using Combo boxes
There are three combo boxes. Each of them contains an icon and a list of options, as shown in the example on the left.

The icon on the left side of any combo box is for inserting a selected item into the text (at the cursor position). The list of options in the first combo box contains all constants, in the second one all functions, and in the last one the actual global variables. Usually x is a variable that varies in the x direction.

The question marks on the right side of the first and the second combo box will give you a short help about a constant or a function. (Usually a value in constant and syntax in function.)

**Using the Display Steps box**

You use the Display Steps box for testing. In this box, you type the number of points you will calculate when you press the Display button in the display area. The number you type in this box is not the number of points this function will calculate in a real calculation. To do the calculation, just press the OK button in the display area.

**Running the Program and Debugging**

The User Defined Function program editor allows you to Debug and Run (Display) the program.

**Run**, the "!" button, has exactly the same function as the Display button. It is put on the Toolbar for convenience.

**Debug**, You can not only run your program but also debug it. If the function is not simple, i.e. it may have an IF - THEN structure for example, and gives you bad results, you can easily debug your program by pressing the Debug button and following the prompts.

In that case, you will see two new windows. The first one contains the Source Code and shows you where you are in debugging; the second one contains a list of all global (system defined) and local (defined by you) variables.
Exploring the Display Area

In the display area, you see the actual graph. You can also define the variable range of x in the From and To boxes.

The From and To boxes

```
From 0
To 50000
```

Since in most cases, the variable values of x in those boxes are real, it is advisable that you don’t change them. Only in Pulse calculation, when the Input Pulse is User Defined and the Peak is set to 0, you may want to change the From and To range. To change the range, just click the desired box (if it is disabled, it will be enabled) and enter your parameters.

The Progress check box

If you enable the Progress check box, you will be able to see the Progress Bar while the program is running. To perform this, you have to enable the Progress check box and press the Display button.

You may want to disable the Progress check box if you are using some output windows or FOR - NEXT loops that will give you many Progress/Message bars.

The Load and Save buttons

You can load or save any functions to disk as a separate text so that you can build your own library of new functions.

Note: After you have explored all the options in the User Defined Function dialog box, click the OK button to accept the definition and return to the Grating Definition dialog box. For more information, see the Appendix A.
The Tools Menu

The Tools menu gives you quick and easy access to the following OptiGrating tools:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Tools</th>
<th>Settings</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>FWHM...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Delay</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export Curve...</td>
<td>Export Complex Spectrum...</td>
<td>View Data...</td>
<td>Crosssection Monitor</td>
<td>Comparison</td>
</tr>
</tbody>
</table>

**FWHM Tools**
Automatically calculates the Full Width At Half Maximum (FWHM) of the current.

**Group Delay**
Automatically calculates the group delay slope, GDD, and ripple.

**Phase**
Selects the Phase Display mode when you are working with Phase graphs. You can toggle between the Circular Phase display and the Cumulative Phase display.

**Profile**
Selects the mode of the Grating Profile display when you are working with Profile graphs. You can toggle between the display of Shape, Chirp, and Apodization.

**Export Curve**
Exports a graph curve into one of the following two formats: Text or BPM_CAD View 2D.

**Export Complex Spectrum**
Exports complex spectrum data into one of the following three formats: Text, BPM_CAD view 2D, or Optisys.

**View Data**
Displays the Data table.

**Crosssection Monitor**
Displays a 2D cut from a 3D Propagation graph.
CHAPTER 4: USER GUIDE

Comparison

‘Curve load...’: Reads data from a file and plots the data on the current view
‘Curve clear’: Clears the curve created by the ‘Curve Load’ option.

Note: You can also get access to some of the Tools menu by double clicking a graph with the left mouse button.

FWHM

File: New > Module option > Tools: FWHM

Using the FWHM Command

The FWHM command helps you calculate the Full Width At Half Maximum (FWHM) characteristics.

To perform a Full Width At Half Maximum calculation
1. Click the graph you are currently working with.
2. From the Tools menu, click FWHM.
3. In the Tools dialog box, enter the desired values, click the Recalculate button, and then click the OK button.
**Note:** The curve to be recalculated is the first visible curve in the graphic window. If you would like to measure another curve, you have to disable the rest of the curves by using the color buttons on the Toolbar.

The FWHM Tools dialog box

FWHM Tools enables you to measure the width, slope, ripple factor, and sidelobes of a curve. The tools are most useful to characterize curves in the spectral domain; however, they can also be used to measure curves in the time domain.

**Note:** The definitions below refer to a typical reflection curve with a central peak surrounded by sidelobes and ripples. In characterizing a typical transmission curve with a pronounced main minimum instead of a main peak, one should re-interpret the definitions accordingly: maximum becomes minimum, etc.

**Bandwidth**

By default, when the At option is not selected, the bandwidth is defined as the full width at half maximum (FWHM). In the selected graph region, the vertical offset from the bottom is excluded from this default measurement. If the At option is selected, the bandwidth is defined as the full width at the given height.
Slope
The slope is defined as the first derivative of the curve at a given position. There are two default horizontal positions for the slope measurement. They are determined by the cross-section of the curve and the horizontal line used to measure the bandwidth.

Slope L is the slope at the left cross-point.
Slope R is the slope at the right cross-point.

Peak
Peak Position is the horizontal position of the maximum value.
Peak Value is the maximum value of the curve.

Ripple Factor
Ripple Factor is defined by:

\[
RippleFactor = \frac{Y_{\text{max}} - Y_{\text{min}}}{Y_{\text{max}} + Y_{\text{min}}}
\]

where \( Y_{\text{max}} \) is the maximum value of the curve, \( Y_{\text{min}} \) is the minimum value of the curve in the selected region. The best way to determine the ripple factor is to limit the selected region to the ripple section only, that is, excluding the main peak.

Sidelobe
Sidelobe is defined as the maximum peak outside the main peak.
Sidelobe L is the left sidelobe
Sidelobe R is the right sidelobe
Sidelobe Position is the horizontal position of the sidelobe maximum
Sidelobe Value is the value of the sidelobe maximum

Group Delay
The Group Delay tool is used for grating dispersion management.

To open the Group Delay Tool

1. File > New.
2. Select one of the options.
3. Click the Calculate button on the left.
4. Choose Spectrum from the drop-down menu.
5. To activate Group Delay, either the Phase, Delay, Dispersion, or Scan tabs must be selected.
6. Once a tab is selected, Tools > Group Delay, or select the Group Delay icon on the task bar beside the FWHM Tool icon.
**Spectrum Range**
Set the wavelength delay range in the From and To boxes. This allows for more freedom when determining where the delay begins and where it ends as indicated by the vertical black lines. Click Recalculate to see changes.

**Bandwidth Level**
To activate, select box to left of Bandwidth Level. This offers a close approximation of the beginning and end points of the delay. You may enter different bandwidth levels in right-hand box to further refine selection. Click Recalculate to see changes.

**Maximum Fitting order**
To get the most accurate results from the Group Delay tool, use Maximum Fitting Order to trace the delay itself. By changing this number, you are better able to map its length. Each step is listed in the Results box, showing both the Coefficients and the Standard Deviations of the delay. Click Recalculate to see results.
Export Curve

File: New > Module option > Tools: Export Curve

Using the Export Curve Command

The Export Curve command allows you to export a graph curve into a text format or a BPM, CAD View 2D format.

To define the Export Curve options

1. Click the graph you are currently working with.
2. From the Tools menu, click Export Curve to open the export Curve dialog box.
3. In the Export Curve dialog box, choose the graph component you want to export: Transmission 1, Transmission 2, Reflection 1, or Reflection 2.
4. From the Export Format list box, choose either Text or BPM_CAD View 2D.
5. Click the Export button.

Note: The Text format is x y.

0.000000e+000 1.000000e+000
8.313872e+001 9.999998e-001
1.662774e+002 9.999993e-001
2.494162e+002 9.999984e-001
.....

The BPM_CAD native format (*.dat) is almost the same as the Text format, but it contains additional information, such as the number of points (in the example below, there are 501 points) in header:

BCF2DPC
501
0.000000e+000 1.000000e+000
8.313872e+001 9.999998e-001
1.662774e+002 9.999993e-001
2.494162e+002 9.999984e-001
CHAPTER 4: USER GUIDE

Crossection Monitor

File: New > Module option > Tools: Crossection Monitor

Using the Crossection Monitor command

1. Click the graph you are currently working with.
2. From the Calculation list box, choose Propagation.
3. In the graph window, click the 3D tab.
4. From the Tools menu, click Crossection Monitor to open the Crossection Monitor dialog box.

5. Click the 3D graph with the left mouse button and holding down the button drag the mouse in x direction until you see a cutting line and a cross section appearing in the graph window.

Note: You can resize the Crossection Monitor dialog box to suit your preferences.

If you click the right mouse button at the cross section of the coordinates displayed in the Crossection Monitor dialog box, a pop-up menu opens which allows you to use the Normalize To Maximum command or the Print command.

The Normalize To Maximum command will maximize the Crossection Monitor dialog box, and you will be able to see the graph in detail.
The Settings menu gives you a fast and easy access to the General and Display Settings dialog boxes and to the Profile Palette.

**General Settings**

**File: New > Module option > File: Settings > General**

**Using the General Settings command**

The General Settings command allows you to define the general settings you will use in the selected graph display. It opens the General Settings dialog box in which you can define the following characteristics: Color, Viewport Border, General Caption, and Digit Font Size.

**General Caption**

Gives you options for the horizontal X-axis of the graphical display.

*Note:* You can save the display data to the *.ifo data file if you enable the appropriate check box.
To open the General Settings dialog box

1. File > New.
2. In the New dialog box, click one of the five modules.
3. From the Settings menu, click General.
4. In the General Settings dialog box, set your preferences for color, viewport border, general caption, and digit font size.
5. Click the OK button.

Note: There are numerous symbols supported by the program. They include Greek symbols, mathematical symbols, and special symbols. To display a symbol, enter the symbol name preceded by a backslash: \symbol name. For example, to display the Greek symbol \lambda, enter \lambda. The backslash affects only the next symbol name. However, the symbol name must be separated from the following character by a space. For example, to display \mu m, enter \mu m.

Display

File: New > Module option > Settings: Display

Using the Display Command

The Display command allows you to define the display settings you will use in OptiGrating. The Display command opens the Display Properties dialog box in which you have two options: changing the Y caption and changing the title of your calculations.

![Display Properties dialog box](image-url)
To open the Display Properties dialog box

1. File > New.
2. In the New dialog box, click one of the five modules.
3. Click the graph you are working with.
4. From the Settings menu, click Display.
5. In the Y Caption boxes, change the Y caption of your calculations.
6. In the Title box, write a new title for your calculations.
7. Click the OK button.

Note: The X captions are common for all calculations. You can change them in the General Settings dialog box.

Re-sampling 3D Propagation Graphs

To define the properties of a graph in 3D view, you have to open not the Display Properties dialog box but the 3D Graph Properties dialog box. In this box you can resample a 3D Propagation graph.

The resampling will speed up your 3D Propagation display, but it won't affect your calculation. Even if you calculate 500 points in the propagation direction, you will see that the graph will be re-sampled according to the value specified in the 3D Graph Properties dialog box.

To define a graph's properties when working in a 3D view

1. Click the graph you are working with and click the 3D tab.
2. From the Settings menu, click Display to open the 3D Graph Properties dialog box.
3. In the 3D Graph Properties dialog box, type the number of points for resampling in the X direction.
4. Click the OK button.

Note: To access the 3D Graph Properties dialog box, you can also click the graph with the right mouse button and from the pop-up menu select Display Options.
Profile Palette

File: New > Module option > Settings: Profile Palette

Using the Profile Palette Command

The Profile Palette command becomes available in the Settings menu when you are working in the Profile or in the 3D Propagation window. You can choose one of the following predefined palettes: Rainbow, Gray Scale, Red, Green, and Blue.

To open the Palette Selection dialog box

1. In the Project window, click either the Profile tab or the 3D tab.
2. From the Settings menu, click Profile Palette to open the Palette Selection dialog box.

3. In the Palette Selection dialog box, click one of the five buttons – Rainbow, Gray Scale, Red, Green, or Blue – to enable it.
4. Click the OK button.

Note: If you are going to print a 3D graph on a black and white printer, it is advisable that you select the Gray Shade palette option.
The Window Menu

The Window menu allows you to use the following commands: New Active Window, New Multiple Window, New and Tile, Cascade, Tile, Arrange Icons, and Next.

New Active Window
Clones the window you are currently working with.

New Multiple Window
Clones the window and the project you are working with. This command is very useful when you want to organize the results of a project as a multigraph display. To achieve this, multiply the display by cloning and change the display option in each cloned window.

New and Tile
Creates new window and tiles it.

Cascade
Cascades the existing windows.

Tile
Tiles the existing windows.

Arrange Icons
Arranges icons of existing windows.

Next
Makes the next window active.
The Help Menu

The Help menu offers a choice of the two options: Help Topics and About OptiGrating.

<table>
<thead>
<tr>
<th>Help Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>About IFO_Gratings...</td>
</tr>
<tr>
<td>System Info...</td>
</tr>
</tbody>
</table>

**Help Topics**
Displays the OptiGrating Help topics.

**About OptiGrating**
Displays the information about the current version of the program.

**System Info**
Displays the information of your computer.
Notes:
APPENDIX A: SCRIPT LANGUAGE FOR USERDEFINED FUNCTIONS

The script language OptiGrating 4.2 uses is a programming language based on the BASIC language syntax. You use the script language to define the shape, chirp, and apodization of a grating. To enter this definition, you have to choose the User Defined option.

Variables, Arrays, and Operators

Variables

A variable name can be any string beginning with a character. You cannot use special characters and operators in the name. Some names are reserved for commands, predefined constants, and functions. Variable names are case sensitive. For example, ‘a’ is not the same as ‘A’; ‘Pos’ is not the same as ‘pos’ or ‘POS’.

Examples:
Valid variable names: a, pos, lambda, width1
Invalid variable names: *a, _pi, IF, RETURN

Note: Comment lines in the editing area are preceded by the double slash symbol //.

Arrays

You can use only one-dimensional arrays. You do not have to declare an array before using it. For the array index, you can use a positive or a negative integer. The usage format is array_name[index].

Examples:
A[2]
B[-3]
a[x]=x*2

Mathematical Operators

OptiGrating supports the following standard mathematical operators. (listed in decreasing priority):

^ power
* multiplication
/ division
+ addition
- subtraction
APPENDIX A: SCRIPT LANGUAGE FOR USERDEFINED FUNCTIONS

Boolean Operators

OptiGrating supports the following standard Boolean operators.

= equal to
< less than
> more than
& and
| or

Examples:
A=b
A<b
B&c
C|d

Comparison Operators

The Comparison operators can be combined:

a<=b; a<>b; a=>b

Commands and Statements: RETURN, IF, ERROR

All command and statement names must be in upper case letters.

Examples:
IF is a command
If or if can be a variable

The script language has a set of commands and control statements. However, not all of them are needed to define user shape, chirp, and apodization. Therefore, here is a list of the commands useful in OptiGrating.

The RETURN Command

The RETURN keyword terminates execution of the program in which it appears and returns the control (and the value of expression, if given). Notice that if you don’t specify RETURN in your program, the interpreter will return the value of expression in the last logical order. You usually use the RETURN command if your program uses IF – THEN commands.

Syntax: RETURN[expression]

Example 1:
A program with only one line (you don't have to specify RETURN)

sin(3)*24+13*(2+6)

returns 107.38688. The same result is obtained from the program:

RETURN sin(3)*24+13*(2+6)
Example 2:
Consider the program:

```plaintext
cp = 100
a = Length-x
IF x<cp THEN
    RETURN x
ELSE
    RETURN a
```

The above program returns x if x is less than 100. Otherwise, it returns Length-x if x is larger or equal than 100.

Example 3:
Let’s modify the previous example, Example 2, as follows:

```plaintext
cp = 100
a = Length-x
IF x<cp THEN
    b = x
ELSE
    b = a
RETURN b
```

This example gives the same result as Example 2. The difference is that another variable b is used instead of returning the value of a directly.

**The IF Statement**

The IF statement controls conditional branching. The body of an IF statement is executed if the value of the expression is nonzero. The syntax for the IF statement has two forms.

Syntax1: IF expression THEN statement
Syntax2: IF expression THEN statement ELSE statement

In both forms of the IF statement, the expressions, which can have any value, are evaluated, including all side effects.

In the first form of the syntax, if expression is nonzero (true), the statement is executed. If expression is false, statement is ignored. In the second form of syntax, which uses ELSE, the second statement is executed if expression is false. With both forms, control then passes from the IF statement to the next statement in the program.

Examples:
The following are examples of the IF statement:

```plaintext
IF i > 0 THEN y = x / i ELSE x = i
```
In this example, the statement \( y = \frac{x}{i} \) is executed if \( i \) is greater than 0. If \( i \) is less than or equal to 0, \( i \) is assigned to \( x \).

For nesting IF statements and ELSE clauses, use BEGIN – END to group the statements and clauses into compound statements that clarify your intent. If no BEGIN - END are present, the interpreter resolves ambiguities by associating each ELSE with the closest IF that lacks an ELSE.

```plaintext
IF i > 0 THEN  // Without BEGIN - END
    IF j > i THEN
        x = j
    ELSE
        x = i
```

The ELSE clause is associated with the inner IF statement in this example. If \( i \) is less than or equal to 0, no value is assigned to \( x \).

```plaintext
IF i > 0 THEN
BEGIN  /* With BEGIN - END */
    IF j > i THEN
        x = j
END
ELSE
    x = i
```

The BEGIN - END enclosing the inner IF statement in this example makes the ELSE clause part of the outer IF statement. If \( i \) is less than or equal to 0, \( i \) is assigned to \( x \).

**The ERROR Keyword**

The ERROR keyword stands for a constant and returns the error code (if any). In case of a mathematical error, like division by zero or overflow, it will reset the error flag.

The constant returns the error code (if any) and in cases of mathematical errors (division by zero, overflow, etc.) resets the error flag. This allows you to detect any unexpected errors during calculation. The best example is to use the ERROR command in the IF-THEN-ELSE statement.

Example 1:
The following one-line program

```plaintext
Length /x
```
results in the Error message: Division by zero, b=Length/x?????

This occurs because initially \( x \) has been set to 0.

Example 2:
Consider the program:
b=Length/x
IF ERROR THEN
    b=100;
RETURN b

Now, whenever we have a mathematical error, b is set to 100 and the program will continue without the error message.

ERROR is a constant, and you cannot assign any other value to it.

The FIRSTTIME Keyword
Flag – indicates FIRST time internal run.

Example:
S =7
IF FIRSTTIME THEN
    RETURN 100
RETURN x*s

Input dialog box
This dialog will appear if you use INPUT or GINPUT in User Defined Functions.

Syntax:
INPUT variable
INPUT “string” variable
INPUT “string” variable = init value
GINPUT variable=init value
GINPUT “string” variable = init value

Example INPUT
Usage of INPUT is limited. Because in OptiGrating you use user defined functions usually in a loop, INPUT will ask you to input data every time you repeat the loop (usually more than 100 times). To avoid this and to avoid redundant programming (IF FIRSTTIME THEN ...), use the function GINPUT (general input), which will ask you for input data only the first time you enter the loop.

INPUT variable
INPUT “string” variable
INPUT “string” variable = init value
Example:
\begin{verbatim}
b=1
MAX = 8
INPUT “Factorial of:” MAX
......
\end{verbatim}
You will get the same effect if you use:
\begin{verbatim}
b=1
INPUT “Factorial of:” MAX = 8
\end{verbatim}
You will be asked to type a value in the Factorial Of box in the Input window.

\textit{Note:} The initialization of MAX before INPUT is not necessary. If you delete the line \texttt{MAX = 8}, the default value in the Input box will be 0.

Example \texttt{GINPUT}

\begin{verbatim}
GINPUT variable=init value
GINPUT “string” variable = init value
\end{verbatim}
(general input)
Displays an Input window on the screen. (The text is optional.)
If the whole program (User Defined Function) is running more than once in the logical (internal) block, \texttt{GINPUT} will ask you to enter data only the first time the program runs.

Example:
In OptiGrating, you will use the Apodization function:
\begin{verbatim}
s=4
tanh(s*(x/Length))*(tanh (s*(1-x/Length)))
\end{verbatim}
Because each grating length is divided into a number of steps (let’s say 25), this function will be called more than once per grating (25 times).

\textit{Note:} Variable \texttt{x} will vary in each step: \texttt{x(actual) = x(previous) + Length/25}

In the Apodization function, you have one parameter “\texttt{s}” for changing the shape of the apodization function. If you want to test different shapes, you will need to change the value for each calculation. Instead of going through all dialog boxes and buttons to reach the User Function dialog box, whenever you want to change “\texttt{s}”, you can use the \texttt{GINPUT} function:
APPENDIX A: SCRIPT LANGUAGE FOR USERDEFINED FUNCTIONS

GINPUT “Input Shape parameter” s=4
\( \tanh(s*(x/\text{Length}))*(\tanh(s*(1-x/\text{Length}))) \)

You will be asked to input different “s” values each time you press the Calculation button. Thus, you will be able to try different apodization shapes very quickly and easily.

Constants

Mathematical Constants

\( \pi \) 3.14159265358979323846
\( e \) 2.71828182845904523536

Physical Constants

\( _c \) 2.9979e8 m/s Speed of light in free space
\( _e \) 8.8542e-12 F/m Permittivity in free space
\( _mi \) 4*\( \pi \)*10e-7 H/m Permeability in free space
\( _q \) 1.60219e-19 C Elementary charge
\( _me \) 9.1095e-31 kg Free electron mass
\( _u \) 1.660531e-27 kg Atomic mass unit
\( _mp \) 1.672614e-27 kg Proton rest mass
\( _mn \) 1.674920e-27 kg Neutron rest mass
\( _eV \) 1.60219e-19 J Energy unit (electron-volt)
\( _h \) 6.626e-34 Js Planck constant
\( _hr \) 1.05459e-34 Js Reduced Planck Constant
\( _lc \) 2.4263096e-12 m Compton wavelength of electron
\( _Ry \) 13.6058 eV Ryberg energy
\( _ri \) 1.09737312e7 1/m Rydberg constant
\( _kT \) 25.853 meV Thermal energy
\( _NA \) 6.022045e23 Avogadro number
\( _f \) 9.648 6e4 C/mol Faraday constant
\( _a \) 7.297351e-3 Fine structure constant
\( _a0 \) 5.2917715e-11 m Bohr radius
\( _re \) 2.817939e-15 m Electron radius
\( _mb \) 9.274096e-24 J/T Bohr magnetron
\( _kB \) 1.3807e-23 J/K Boltzmann constant
\( _sb \) 5.66961e-8 Stefan-Boltzmann constant
Functions

Commonly Used Functions

\[
\begin{align*}
\text{sin}(\text{radian}) & \quad \text{sine} \\
\text{asin}(0..1) & \quad \text{radian} \\
\text{sinh}(x) & \quad \text{hyperbolic sine of } x \\
\text{cos}(\text{radian}) & \quad \{0..1\} \\
\text{acos}(0..1) & \quad \text{radian} \\
\text{cosh}(x) & \quad \text{hyperbolic cosine of } x \\
\text{tan}(\text{radian}) & \quad \{0..\text{inf}\} \\
\text{atan}(0..1) & \quad \text{radian} \\
\text{exp}(x) & \quad e^x \\
\text{ln}(x) & \quad \log \text{ in base } e \\
\text{log}(x) & \quad \log \text{ in base } 10 \\
\text{deg}(\text{rad}) & \quad \text{radians into degrees} \\
\text{rad}(\text{deg}) & \quad \text{degrees into radians} \\
\text{fact}(x) & \quad x \text{ factorial (}x!\text{)} \\
\text{sqrt}(x) & \quad \text{square root of } x \\
\text{pow}(x,n) & \quad x^n
\end{align*}
\]

Other Functions

\[
\begin{align*}
\text{min}(a,b) & \quad \text{=} a \text{ if } a < b \text{ else } b \\
\text{max}(a,b) & \quad \text{=} a \text{ if } a > b \text{ else } b \\
\text{comb}(n, k) & \quad \text{number of combinations for } k \text{ object, } n - \text{total number of objects } (n \geq m), \text{ return 0 if error} \\
\text{perm}(m, n) & \quad \text{permutation } mPn \ (0 \text{ if error}) \\
\text{gcd}(a, b) & \quad \text{Greatest Common Divisor between } a \text{ & } b \\
\text{lcm}(a, b) & \quad \text{Largest Common Multiple between } a \text{ & } b \\
\text{frc}(x) & \quad \text{fractional part of } 'x' \\
\text{int}(x) & \quad \text{integer part of } 'x' \\
\text{angle}(x,y) & \quad \text{Computes angle from Cartesian position (x,y), angle defined positive if } y > 0 \text{ and negative if } y < 0 \\
\text{rand}(\text{MaxNum}) & \quad \Rightarrow \text{Randomize } \{0..\text{MaxNum}\}
\end{align*}
\]

Fresnel Integral

\[
\begin{align*}
\text{fresnel_s}(x) & \quad \text{Fresnel Integral SIN} \\
\text{fresnel_c}(x) & \quad \text{Fresnel Integral COS}
\end{align*}
\]

Evaluates the Fresnel integrals
fresnel_ffresnel_f(x) = function f(x) related to the Fresnel Integral
fresnel_g(x) = function g(x) related to the Fresnel Integral

Evaluates the functions f(x) and g(x) related to the Fresnel integrals by means of the formulae

\[
S(x) = \int_{0}^{x} \sin\left(\frac{\pi}{2} t^2\right) dt
\]

\[
C(x) = \int_{0}^{x} \cos\left(\frac{\pi}{2} t^2\right) dt
\]

\[
f(x) = \left\{ 1/2 - S(x) \right\} \cos(\pi x^2/2) - \left(1/2 - C(x) \right) \sin(\pi x^2/2)
\]

\[
g(x) = \left(1/2 - C(x) \right) \cos(\pi x^2/2) - \left(1/2 - S(x) \right) \sin(\pi x^2/2)
\]

**Gamma Functions**

Computes the value of the gamma function at x

\[
\Gamma(x) = \int_{0}^{\infty} t^{x-1} e^{-t} dt
\]

\[
\text{gamma}(x) \text{ Gamma Function}
\]

\[
\text{lgamma}(x) \text{ Natural logarithm of Gamma Function, } x \text{ - must be positive}
\]

**Error Function**

\[
\text{erf}(x) \text{ Error Function}
\]

\[
\text{erfc}(x) \text{ Complementary Error Function}
\]

Computes the error function erf(x) and Complementary error function erfc(x)
When $x > 26$ then $\text{erf}(x) = 1$ and $\text{erfc}(x) = 0$
When $x < -5.5$ then $\text{erf}(x) = -1$ and $\text{erfc}(x) = 2$

nexperfcNon exp erfc computes $\exp(x^2) \text{erfc}(x)$

i.e. $\text{nexperfc}(x) = \frac{2 e^{x^2}}{\sqrt{\pi}} \int_{x}^{\infty} e^{-t^2} dt$

Inverse error function $y(x)$

inverf($x$, minx)

Evaluates the inverse error function $y(x)$ where

$$x = \frac{2}{\sqrt{\pi}} \int_{0}^{y(x)} e^{-t^2} dt$$

$x$ - it is necessary that $-1 < x < 1$
if $|x| > 0.8$ then value of $x$ is not used in the procedure

minx if $|x| \leq 0.8$ then value minx is not used in the procedure

if $|x| > 0.8$ then minx has to contain the value of $1 - |x|$

In the case that $|x|$ is in the neighborhood of 1, cancellation of digits take place in the calculation of $1 - |x|$

If the value $1 - |x|$ is known exactly from another source, then minx has to contain this value, which will give better results.
**Bessel Functions**

**Bessel function J**

\[ \text{bessj}0(x) - \text{Bessel function } J_0(x) \text{ of the 1st kind of order 0} \]
\[ \text{bessj}1(x) - \text{Bessel function } J_1(x) \text{ of the 1st kind of order 1} \]
\[ \text{bessj}[k](x) - \text{Bessel function } J_k(x) \text{ of the 1st kind in order } k \]

**Bessel function Y (Weber’s function)**

\[ \text{bessy}0(x) - \text{Bessel function } Y_0(x) \text{ of the 2nd kind of order 0} \]
\[ \text{bessy}1(x) - \text{Bessel function } Y_1(x) \text{ of the 2nd kind of order 1} \]
\[ \text{bessy}[k](x) - \text{Bessel function } Y_k(x) \text{ of the 2nd kind of order } k \]

**Modified Bessel function I**

\[ \text{bessi}0(x) - \text{Modified Bessel function } I_0(x) \text{ of the 1st kind of order 0} \]
\[ \text{bessi}1(x) - \text{Modified Bessel function } I_1(x) \text{ of the 1st kind of order 1} \]
\[ \text{bessi}[k](x) - \text{Modified Bessel function } I_k(x) \text{ of the 1st kind of order } k \]

**Modified Bessel function K**

\[ \text{bessk}1(x) - \text{Mod. Bessel function } K_0(x) \text{ of the third kind of order 0} \]
\[ \text{bessk}1(x) - \text{Mod. Bessel function } K_1(x) \text{ of the third kind of order 1} \]
\[ \text{bessk}[k](x) - \text{Mod. Bessel function } K_k(x) \text{ of the third kind of order } k \]

**Spherical Bessel functions**

\[ \text{spbess}[k](x) \Rightarrow \text{Spherical Bessel funct. } J_k+0.5(x) \]

**Chebyshev Polynomials**

\[ \text{chepol}(n,x) - \text{Computes the value of the Chebyshev polynomial } T_n(x) \]

\[ T_0(x) = 1, \quad T_1(x) = x \]

\[ T_i(x) = 2xT_{i-2}(x), \quad i = 2, \ldots n \]
APPENDIX A: SCRIPT LANGUAGE FOR USERDEFINED FUNCTIONS

Conversions

**Length**

- ft_m ft_m(foot) Foot to meter
- yd_m yd_m(yard) Yard to meter
- in_m in_m(inch) Inches to meter

**Temperature**

- c_k c_k(celsius) Celsius to Kelvin
- fh_k fh_k(fahrenheit) Farenheit to Kelvin
- fh_c fh_c(fahrenheit) Farenheit to Celsius
- k_c k_c(kelvin) Kelvin to Celsius
- c_fh c_fh(celsius) Celsius to Farenheit
- k_fh k_fh(kelvin) Kelvin to Farenheit

**Other Conversions**

- gal_l gal_l(gallon) Gallon to liter
- pt_l pt_l(pint) Pint to liter
- oz_l oz_l(oz) Oz to liter
- in3_l in3_l(cubicInch) Cubic Inch to liter
- l_m3 l_m3(liter) Liter to cubic meter
- pd_kg pd_kg(pound) Pound to kilogram
- phe phe(wavelength[µm]) Calculate Photon energy [eV]
APPENDIX B: View Properties of 2D Graphics

When a View is displayed, it is in the form of a two-dimensional graph, and there are a certain number of properties that can be modified for this graph. Right-clicking anywhere on this Graph View will make a context menu appear with options that can be performed on the Graph View. These options include Zoom In and Zoom Out, Trace Curve, Print, Copy Bitmap, Curve Properties, Axis Properties, Grid Properties, Graph Properties, and Labels.

### Zoom In

The Zoom In option zooms into the graph by dragging a rectangle around the graph, and displays zoomed in values on both axes.

### Zoom Out

Zoom Out returns the graph to default scale (no zoom at all).

### Trace Curve

Trace Curve offers the unique option of tracing a particular curve on this View. When selected, a Select Trace Curve dialog box offering a list of all of the curves on the View appears.
The user selects a curve. The selected curve is being inspected. Moving the cursor moves the crosshair that traces along the selected curve and the window displayed on top of the View will show the X and Y values. This is useful when observing exact values at particular wavelengths or at particular X values, as opposed to just viewing the graph.

From the drop-down box, any other curve in this View can be selected and the crosshair will continue by tracing that particular curve. Selecting the Trace Curve feature again will disable this feature.
Table of Points

This option will show a window, which can be used to view the data points of the curves in the graph.

From the drop down menu, any curve in the view can be selected. The data points of the curve will be displayed in the table. The display format options can be changed by choosing the new display format, and/or by changing the number of digits, and then pressing the Update Format button. The data points of the currently displayed curve can also be saved into a text file, by pressing the Export Text button. This will open the Save dialog box, which will ask for the location to save the file.

Copy Bitmap

The option called Copy Bitmap allows copying the graph as a bitmap to the clipboard and pasting it to any bitmap drawing program for further editing.

Print

Any graph in the system can be printed by right-clicking and selecting Print, which creates a full-page printout of this graph.
Curve Properties

Another option from this menu is Curve Properties. Curve Properties offers a list of curves where the curve color, line style, thickness, and the type of graph points that it will draw can be modified. If too many curves are displayed at the same time, curves can also be set to invisible (and not show up on the graph) to reduce the clutter.
Axis Properties

The next option from the menu is Axis Properties. All the active axes are offered as choices for property modification.

It supports three number formats: floating, exponent and power.

Other parameters for graphs include the number of digits displayed and orientation with respect to the axes. Modification of the axis captions, orientation, as well as the size of the axis (Scale Factor) can be done, as well as the entering of particular mathematical symbols within the caption by choosing the Symbols button in the bottom right corner.

On the right-hand side, the Auto Scale option automatically scales the axes to the graph, as well as the Logarithmic option for logarithmic display of data. The same options are offered for all the axes.
Grid Properties

Grid View Properties supports editing of horizontal and vertical grids. In all grid options, the user can decide whether the grid is visible, where the grids should be positioned (on major or minor tickmarks), the color of the grid, and the line style of the grid.

Graph Properties

The properties of the graph can be edited in the Graph Properties option. The Title box offers the option of editing the caption (title) of a Graph, as well as the position, size, and scale factor.

The Colors option allows for the selection of the colors of the axes and the background.
Labels

Labels in the Graph View can be added by choosing the Label, Add option, and typing it in. Once created, the label can be moved around the graph, using the click and drag technique, in order to label any part of the graph. The labels can also be resized by dragging the corners of a label.
Notes: